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Doel van het document
In dit document vinden de gebruikers van de Domintell-systemen alle informatie die ze
nodig hebben om de mogelijkheden van het domotica systeem volop te benutten. In deze
gebruiksaanwijzing worden de verschillende fases voor het aanmaken van een applicatie
op een duidelijke en gedetailleerde manier beschreven.

Deze gebruiksaanwijzing biedt ook ondersteuning aan eindgebruikers die hun systemen
aan hun eigen behoeften willen aanpassen.

In  dit  document  vindt  u  ook  een  reeks  concrete  voorbeelden  ter  illustratie  van  de
verschillende  programmatiepunten  die  worden  besproken.  Bij  elk  voorbeeld  hoort  een
applicatiebestand dat in de Domintell2 programmatiesoftware kan worden geraadpleegd.

Wij  adviseren  medewerkers  die  verantwoordelijk  zijn  voor  het  aanmaken  van  de
applicaties, vooraf opleidingscursussen te volgen die door speciaal opgeleide instructeurs
worden gegeven.

Aanwijzingen  die  in  cursief zijn  weergegeven,  verwijzen  naar  berichten  die  op  de
bedieningspanelen worden weergegeven (button, vakje om aan te vinken, …).

Aanwijzingen die in vet zijn weergegeven, verwijzen naar menu’s en submenu’s waarin u
een functie kunt vinden.
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Voorbereidende handelingen aan de programmatie 

Selectie   van de   communicatiepoort
De connectie  aan de DGQG01-module  (Master)  vereist  de  keuze  van  de communicatiepoort
(USB, Serie of Ethernet). 

De selectie van de communicatiepoort voert zich uit vanaf het menu Tools > communicatiepoort
> poortselectie. Een dialoogbox stelt de poortselectie voor via de welke de DGQG01 verbind is
aan uw PC.

Om de selectie te bevestigen, klik op OK.

Om de status van de USB-connectie die de DGQG01-module op de PC gebruikt te kennen, open
de  Windows configuratiepaneel > Systeem > Hardware > Apparaatbeheer.  De lijst van de
poorten moet de Domintell DGQG01 USB controller bevatten. 

Als de lijst van de USB BUS-controller de Domintell  DGQG01 USB driver niet  bevat, zijn dan
zonder  twijfel  de  piloten  van  de  USB-driver  niet  geïnstalleerd  geweest.  De  USB-connexie  is
herkend, maar vershijnt als niet-geïnstalleerd. 

Om  de  USB  piloten  te  installeren,  klik  rechts  op  de  Manager  te  installeren,  kies
stuurprogramma's bijwerken. 

Als u van een internet connectie beschikt, opteer voor de automatische installatie. Anders, opteer
voor de handmatige installatie. Een stuurprogramma assistent verschijnt. Geeft de PC de plaats
van het bestand die de drivers bevat aan. Deze bevinden zich op de installatie-CD of op onze
PRO website.  

De assistent vindt en installeert de piloten. Hij verwittigt u wanneer deze unieke procedure over is.
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Klik op Sluiten om de installatie van de drivers te beëindigen. 

Uitvoering van het besturingssysteem in de Master
De DGQG01 moet onvermijdelijk de zelfde versie van het Domintell-besturingssysteem (Master
O.S.) bevatten als die op de PC geinstalleerd is (compiler). 

Opmerking : als de geinstalleerde versie op de PC hoger is dan de versie bevat in de DGQG01, is
enkel de functie Toepassing lezen mogelijk.  

Om het  besturingssysteem in  de  Master  uit  te  voeren,  open  Tools  >  Flasher  >  Master.  De
venster van de Update master  verschijnt. 

Als de O.S. versie niet up to date is, voer het laden uit door op OK te drukken en bevestigt de
behandeling met de knop Ja. De overdracht van het besturingssysteem naar de DGQG01 duurt
ongeveer 8 minuten. De overdracht van een besturingssyteem wist alles wat er in het DGQG01-
geheugen uit.  

Het  is  onmogelijk  om een application  in  de  DGQG01 te overdragen als  de  versies van  het
besturingssysteem in de DGQG01 en in de PC niet dezelfde zijn.

Controleren van de versie van het besturingssysteem (O.S.)

De DGQG01-module 

De O.S. versie dat bevat is in de master wordt gecontroleerd via het menu  Help > Over.  De
Versie Master O.S. en de Versie Compiler moeten identiek zijn. Als het niet zo is, stuur de juiste
versie van de O.S. in de DGQG01 over als er veranderingen moeten overgeschreven zijn. 
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Touchscreens DTSC01 en DTSC03

De touchscreens DTSC01 en DTSC03 beschikken  over een besturingssysteem. Om te
controleren  dat  de  touchscreens  van  hetzelfde  besturingssysteem  beschikken  als  die
aanwezig  is  in  de  DGQG01,  controleer  hun  status  in  het  menu  Tools  >  Flasher  >
DTSC01/03 Scherm.  Voer  het  serienummer van het  touchscreen in  en  controleer.  De
overdracht van het besturingssysteem  aan de touchscreens DTSC01 en DTSC03 voert
zich  uit  via  de  Domintell  BUS-kabel.  De  overdracht  van  de  O.S.  duurt  ongeveer  15
minuten. 

Als er een update nodig is verschijnt het volgende scherm :

Klik op de knop Update om de overdracht te starten : 

Na het laden van het besturingssysteem zal de venster dit tonen : 

Touchscreens DTSC02, DTSC04 en videofoons DVIP01 en DVIP02

Zowel  de  touchscreens  DTSC02  en  DTSC04  als  de  videofoons  DVIP01  en  DVIP02
beschikken over een besturingssysteem. 

1. De module is aangesloten op hetzelfde netwerk als de configuratiecomputer.

• De O.S. versie van de module controleren.

Via het menu Tools > flasher > module's Firmware > Through Ethernet. In de
kolom  Status moet «OS goed geinstalleerd» verschijnen. Als de O.S. niet  goed
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geinstalleerd is, voer de update van de O.S. versie uit. 

• O.S. in de module sturen/flashen via het ETHERNET-netwerk.

Via de FTP-poort (21). De module dat geplaatst is op de Intranet-netwerk is normal
gezien op DHCP-mode (dynamisch IP-adres) geprogrammeerd. Om de flash uit te
voeren is de PC aan Ethernet aangesloten op hetzelfde netwerk als de module. De
PC moet ook van een connectie met de Master (via USB of met Ethernet via de
DETH03-module) beschikken. 

Voer de O.S.-flash via het Domintell2 software uit. In het menu Tools > Flasher >
module's Firmware  > Via Ethernet.  Een configuratievenster verschijnt,  klik op
Flash alle modulen. Als de flash niet start, klik rechts en kies Flash de module.   

Pas op, gedurende de overdracht van de software antwoordt het programma niet
meer.  De  evolutie  van  de  overdracht  van  de  flash  is  beshreven  door  een
percentage. Volgend deze overdracht neemt de update plaats en kan de volledige
initialisatie tijd wel 45 minuten duren.

Onderbreek de voeding van het scherm niet tijdens de update !

Zo snel als de overdracht gedaan is, verlaat het flashvenster. De update voert zich
automatisch uit. 

Het is normaal dat het scherm automatisch herstart tijdens de update. Gedurende
de update van de versie toont het scherm het bericht Updating O.S. 

Zo net als de O.S. geinstalleerd is, herstart de module zich. Wanneer de versie up
to date is, toont de module «NO APPLICATION». Stuur dan de configuratie van de
programmatie ( dap file ) terug naar de Master. De modules zijn klaar.

2. De module is niet aangesloten op het Ethernet-netwerk.
• De O.S. versie van de module controleren. (zie bovenstaande punt)
• De O.S. in het scherm sturen/flashen met een µSD-kaart.

Als het  scherm niet  aan het Ethernet-netwerk van uw installatie aangesloten is,
flash het scherm met een microSD-kaart (µSD). Connecteer de kaart aan uw PC. In
het menu Bestand van de Domintell2 software, voer de kopij van de bestanden uit
dankzij de bediening Bewaren op SD-kaart. Kopieer deze bestanden aan de wortel
van de microSD-kaart. De bestanden niet in een bestaand bestand invoegen. De
bestanden gaan zich automatisch in  het  wortelrepertoire  van de kaart  plaatsen.
(mogelijkheid om de toepassing te kopieren en/of kopieren van de O.S. van het
scherm).
◦ Als de O.S. niet up to date is, selecteer de 2 keuzes.
◦ Als de O.S. up to date is, selecteer alleen de toepassing.
Voeg de microSD-kaart  in  de  kaartlezer  van uw scherm in.  Als  de  O.S.  en  de
toepassing op de kaart zijn, neemt de overdracht automatisch plaats. Na enkele
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minuten vraagt het scherm om de microSD-kaart te verwijderen. Na 30 minuten
moet de teopassing op het scherm verschijnen. Als enkel de toepassing op de kaart
is  gezet,  neemt  de update  30 seconden.  Volg  de aanwijzingen op het  scherm.
Wanneer  de  update  gedaan  is  op  alle  schermen,  verwijder  de  aanwezige
bestanden op de µSD-kaart. 

Laden van lettertypen in de schermen.

Modules  die  door  deze  procedure  betrokken  zijn :  DTSC01,  DTSC03,  DPBTLCD0x,
DAXPBLCD0x en DLCD03.

Laad de lettertypen in de schermen via  het  menu  Tools > Flasher > Lettertype.  Het
volgende scherm verschijnt :

Deze stap is  verplicht  als  de  naam van de module in  rood verschijnt  in  de lettertype
beheerder.

Controleer de taal van de geselectionneerde lettertype. Als de namen van de modules in
zwart zijn, dan moet de lettertype niet upgedate worden. Als integendeel, de naam van
één of meerdere modules rood zijn, moet de update uitgevoerd worden door op Update te
klikken. 

De voortgang van de update is in de onderkant van het venster aangegeven.

Door  Update forceren aan te kruisen zal de lettertype naar alle schermen overgebracht
worden (zelfs als de module het juiste lettertype heeft).

Zo snel als de overdracht gedaan is, moet de naam van alle modules zwart worden (als
dat niet het geval is, herhaal de handeling).
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Aanmaken van een nieuwe toepassing
Om een nieuwe toepassing aan te maken, open het menu  Bestand > Nieuw. Het lege
configuratiescherm verschijnt :

Net scannen
Het scannen van de net staat aan het programma toe om alle modules die geconnecteerd
zijn aan de BUS te detecteren. De opsporing van de modules wordt via het menu Master
> Net scannen uitgevoerd. De vooruitgang van de scan is door dit onderstaande venster
geïllustreerd. 

Alle modules die aangesloten zijn aan de BUS verschijnen aan het scherm wanneer de
opsporing over is. 

Programmatieomgeving

Hoofdscherm
Nadat de basisbewerkingen gerealiseerd zijn, stelt het scherm zich als het volgende voor :

Dit scherm wordt in 3 delen verdeeld : 

De grijze kolom, links van het scherm, toont de verschillende verdiepingen en de
verschillende kamers die het gebouw samenstellen aan. Dit is de boomstructuur
van het project. 

Het middengedeelte van het scherm toont de kolom van de  ingangen  aan. De
ingangsmodules  controleren  de  installatie.  Het  resultaat  van  de  programmatie
door het  slepen en loslaten van een  uitgang op een  ingang verschijnt  op de
ingangsmodules. 

De kolom rechts van het scherm toont de uitgangen aan. De uitgangen voeren
acties op het systeem uit. 

Sommige modules zijn voorzien zowel  van  ingangen als van  uitgangen.  Bv. :
DGSM01, DPBT02,..
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Organisatie van het huis (eerste kolom)
Om de structuur van de installatie te verduidelijken geeft het Domintell-programma een
boomstructuur aan.U zult zo de verschillende kamers in de verdiepingen van het gebouw
kunnen  organiseren  en  er  de  verschillende  ingangen-  en  uitgangenorganen  die
aangesloten zijn aan de BUS verdelen.  

Als een DTSC0x-touchscreen de installatie uitrust geeft de eerste kolom de mogelijkheid
om een standaardconfiguratie van de modules die op het scherm verschijnen te voorzien. 

Verdeling van de kamers en de verdiepingen.

Open de venster opbouw van het huis. In het menu  Project > Verdiep toevoegen. Of,
klik rechts in de eerste kolom > Verdiep toevoegen.  

Het rechtse bovendste deel bevat de  Verdiepingen terwijl het rechtse onderste deel de
kamers bevat. 

Om verdiepingen toe te voegen, kies en sleep het gewenste verdiep naar het linkse deel
van het scherm. Laat de linkse knop van uw muis los. De verdieping verschijnt nu op deze
plaats. 

Om kamers toe te voegen, kies en sleep de gewenste kamer op een verdiep dat  zich in
het linkse deel van het scherm bevind. Laat de linkse knop van uw muis los. 
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Klik op OK wanneer de organisatie van de verschillende verdiepingen en kamers ingesteld
is. 

Oprichting en schrapping van verdiepingen en/of kamers.

Het  is  mogelijk  om nieuwe  verdiepingen/kamers  aan  te  maken  en  om de  bestaande
verdiepingen/kamers te hernoemen. 

Om een verdiep toe te voegen,  klik rechts in de ruimte van de verdiepingen > Verdiep
toevoegen. Een nieuw verdiep verschijnt in de lijst. Hernoem het. 

Om een verdiep te noemen,  kies het gewenste verdiep > klik links > hernoem het
verdiep. Na deze verandering verchijnt er een selectiescherm van pictogrammen. Om een
ander pictogram te kiezen, open Project > Pictogrammen kiezen. 

Om een verdiep te verwijderen, kies het gewenste verdiep > klik rechts > Weglaten. 

Het  toevoegen,  weglaten en  veranderen van  de  naam van  een  kamer  voert  zich  op
dezelfde manier uit als voor een verdiep. 

Verdeling van de ingangen en uitgangen in de kamers.

De verdeling van de elementen voert zich uit :

. Ofwel via het hoofdscherm. Kies elke gebruikte component ( ingang of  uitgang),
sleep de component naar de kamer waar hij geinstalleerd is.

. Ofwel via het menu Project > Inrichting. Neem de ingang- en uitgangelementen
om ze in de boomstructuur te rangschikken. 

Tijdens de selectie van een element van de boomstructuur verschijnen de ingangen en
uitgangen die er zijn gerangschikt. 

De ingangsmodules (tweede kolom)
Dat  zijn  alle  modules  die  de  mogelijkheid  geven  om een  bedieninginformatie  aan  de
DGQG01 (Master) te sturen. De lijst van de modules bevindt zich in het hoofdstuk 'module'
van deze handleiding. 
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De uitgangsmodules (derde kolom)
Dat  zijn  alle  modules  die  kunnen  bediend  worden  door  de  DGQG01  (Master).  Deze
modules voeren acties afhankelijk van de programmatie bevat in de DGQG01 uit. De lijst
van de modules is overgenommen in het hoofdstuk 'module' van deze handleiding. 

Organisatie van de programmatie
De volgende punten geven de mogelijkheid om de orde van de linken binnen de applicatie
te veranderen.

Verandering van de naam van de elementen 

Alle  ingangen en  uitgangen  kunnen  hernoemt  worden  om  de  programmatie  te
vergemakkelijken.  Hetzelfde  geldt  voor  de  groepen,  de  variabels,  de
temperatuursensoren, de IR sensoren en de uurwerken. Om de naam van een element te
veranderen, kies het element > klik rechts > Bewerken. 

Om de  naam van  alle  elementen  van  een module  te  veranderen,  kies  één van de
elementen van de module > klik rechts > Berwerken. Hernoem elk element van de
module. 

De element waardoor de module bewerkt is verschijnt in het rood in de lijst. 

 Alle  componenten hernoemen geeft  een toekomstige  gemak in  de  programmatie.
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Gebruik eenvoudige en intuïtieve namen. 

Verplaatsing van de linken

Wanneer meerdere uitgangen verbonden zijn aan een zelfde ingang is het mogelijk om
de orde van de linken op deze  ingang te wijzigen. Klik rechts op één van de linken en
breng de link naar boven of breng de link naar beneden. 

 De orde van de linken is  belangrijk  wanneer ze de waarde van een variabel  als
conditie hebben. Deze linkverplaatsing geeft aan het programma een betere ergonomie. 

Bijvoorbeeld : Als het verhogen van de ventilatiesnelheden zich volgens de waarde van
een variabel uitvoert en dat deze verhoogt wordt bij elke druk op een aangewezen knop.
Dan zal de volgende actie volgens de nieuwe waarde van de variabel uitgevoerd worden.  

Als de variabel in de laatste positie is, zullen de linken volgens de voormalige waarde van
de variabel uitgevoerd worden en dan zal de variable verhoogd worden.

Organisatie van de uurwerken.

Om  de  programmatie  te  organiseren  zoals  het  u  past,  is  het  ook  mogelijk  om  de
aangemaakte klokken te verplaatsen. Klik rechts op één van de uurwerken, kies de optie
uurwerk naar boven of uurwerk naar beneden. 

Om de uurwerken op chronologisch volgorde te  sorteren,  klik  rechts  op de pictogram
Uurwerken en kies de optie Sorteren.

  Het  gaat  alleen  maar  om  een  ergonomische  functionaliteit.  Een  uurwerk
verplaatsen beînvloed het inschakelen op het gekozen uur niet. 

Ingangen/Uitgangen lokaliseren

Gebruik  de  optie  Master  en  PC  actief om  de  ingang-  en/of  uitgangelementen  te
lokaliseren. Connecteer de PC aan de DGQG01. Kies de optie Master en PC actief. Een
actie  op  een  Ingang zal  verwijst  worden  door  de  groene  kleur  van  de  betrokken
ingangpictogram. 

De optie Toon laatste actie onderstreept de laatste geactiveerde Ingang (menu Opties >
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Toon laatste actie).

Om  de  staat  van  de  Uitgangen via  de  PC  te  wijzigen,  klik  op  de  betrokken
Uitgangpictogram. De staat wordt door de kleurverandering of de symboolverandering
van de pictogram aangegeven. De Master en PC actief-mode beheert enkel de korte druk
functie.  

Elementen in de applicatie opzoeken

De functie Opzoeken is geldig voor alle Ingangen, Uitgagen, Variabels en Groepen. Ze
situeert  de  plaatsen  van  de  elementen  in  het  configuratiebestand  en  onderstreept  de
linken die er betrekking mee hebben. Vanaf het element dat op te zoeken is, klik rechts en
kies  de  optie  Opzoeken.   Het  onderstaande  geillustreerde  venster  verwijst  naar  alle
plaatsen waar het element geregistreerd is.

De selectie van één van de plaatsen in dit venster verwijst rechtstreeks naar de plaats van
de link die er betrekking mee heeft in de configuratieprogramma.

Opties menu

Het menu Opties beheer de ergonomie van het PC. De opties in dit menu geven voor elke
component aan : 

• Zijn serienummer : Module n° tonen

• De  plaats  in  de  woning  waar  de  Ingangen en  Uitgangen zich  bevinden :
Verdiep/Plaats tonen

• Zijn type : Type tonen

Het menu geeft ook :

• De weergave of niet  van de voortgang van een applicatieverzending :  Toon de
informatie van de verzending. 
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• De keuze van een taal tussen 23 voorgestelde talen : Kies uw taal 

• De ontwikkeling of het vermindering van alle linken van de programma : Sluit alle
linken / Open alle linken.

Rapport aanmaken

Een verslag geeft alle details van de programmatie aan. Hij is voortgebracht via het menu
Tools  >  Rapport  aanmaken.  Dit  document  geeft  een  overzicht  van  de  applicatie
gedurende en na de programmatie aan de gebruiker.
De Ingangen zijn volgens hun plaats gerangschikt. De volgende informaties zijn gegeven :

• bestuurde uitgang(en)
• actietype aangesloten aan elke uitgang
• instellingen van de link

Zowel de Uurwerken als hun instellingen zijn er in vermeld. 

Sla de applicatie op alvorens het verslag  aan te maken .  

 Om  het  begrip  van  het  verslag  door  de  gebruiker  te  vergemalijkken  is  het
essentieel alle elementen van de installatie duidelijk te noemen. Deze behandeling is op
een intuïtieve en gecoördineerde wijze gedaan. 

Manueel modules toevoegen

Voeg virtuele modules via het menu Tools > Module bijvoegen. Kies het type en dan de
module om toe te voegen. 

 Voer de virtuele programmatie van een installatie voor de bedrading en voor het
scannen van de modules uit. Deze tool geeft de mogelijkheid een testapplicatie te creëren
om  het  Domintell2-omgeving  te  leren  kennen.  Het  gaat  hier  niet  over  een
installatiewerking-simulator.  

De  geselectionneerde  module  beschikt  van  een  virtueel  adres.  Dit  serienummer  kan
daarna verandert worden. Klik op OK om te valideren.
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 Zonder  kennis  te  hebben van het  serienummer  van de module  die  uiteindelijk
geinstalleerd zal zijn, bewaar de standaard serienummer. 

Als de serienummer onveranderd is, zal de nieuwe module in het hoofdscherm van de
programma met de vermelding « niet gescanned x » verschijnen.

Na de bedrading van de domotische modules, vervang de virtuele modules die aanwezig
zijn in de programma door geinstalleerde modules. Volg de aanwijzingen die beschreven
worden in het punt 'vervanging van modules'.  

Vervanging van modules

Een virtuele of defecte module van hetzelfde type vervangen zonder 
programmatieveranderingen uit te voeren. 

In het geval van een defecte module voer eerst de fysische vervanging op de BUS. Scan
het netwerk (Master > Netwerk scannen). Een bericht signaleert dat de module afwezig
is,  klik  op  OK.  Het  scherm  Beheer  van  de  modules verschijnt.  Hij  bestaat  uit  3
kolommen :  

• Aanwezige  modules :  De  gedetecteerde  modules  op  de  netwerk  zijn  er
aangegeven. Het aantal tussen [ ] stelt het aantal gescanneerde modules voor. 

• Afwezige modules : De niet-gedetecteerde modules op het netwerk (losgekoppelde
of defecte modules) zijn er aangegeven. Het aantal tussen [ ] wijst naar het aantal
afwezige modules. 

• Nieuwe  modules :  De  gedetecteerde  modules  tijdens  de  laatste  scan  van  de
netwerk  worden hier  aangegeven.  Het  aantal  tussen  [  ] stelt  het  aantal  nieuwe
gescande modules voor.  

 

In de kolom van de afwezige modules, klik rechts op de module die te vervangen is en
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kies Uitwisselen. 

Gebruik het rol menu en kies het nummer van de module die te vervangen is. Valideer
door op de knop Vervangen te drukken. Klik op OK.   

 

Na deze  behandeling  zijn  de  kolommen van de  Afwezige  modules- en   de  Nieuwe
modules  leeg.  Klik  op  OK en  stuur  de  applicatie  naar  de  Master  over  zodat  de
verandering effectief wordt.  
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De modules
De verdeling van de volgende titles volgt de orde die bepaald is in het menu toevoegen
van  een  module van  de  Domintell2  software.  Het  gaat  over  de  beschrijving  van  de
software functies van de modules.  

Sommige modules beschikken zowel  van ingangen als  van uitgangen.  Bv. :  DGSM01,
DPBT02,..  Ze verschijnen zowel in de hoofdkolom (ingangen) als in de rechtse kolom
(uitgangen).

 Bijvoorbeeld : de DGSM01-module stuurt een SMS dat een inbraak meldt. Men kan dan
een SMS naar de installatie sturen dat bv alle lampen van de installatie aansteken om de
dief te doen vluchten.

Ingang

Algemene informaties

De  modules  van  ingang-type  verschijnen  in  het  hoofdgedeelte  van  het  Domintell2-
programma, in de linkse ingangen-kolom. De ingangen dienen voor de commando's van
de installatie. In de ingangen-kolom verschijnen de linken van de programmatie.

.Beheer van de dubbeldruk     :

De dubbeldruk-functie schakkelt de uitgang van de link in op een korte of een lange druk
van de ingang. Een druk is lang beschouwd na een vaste periode van 0,4 seconden. 

Om een  lange  druk te  kunnen kiezen  is  het  noodzakelijk  om de « 2 functies » in  de
instellingen van de ingang-module te kiezen.  

 Bevestig de lange druk NIET  als er geen programmatie van de link bestaat  en gebruikt wordt
op deze knop . Dit om te voorkomen dat geen actie op de knop wordt uitgvoerd bij het iets wat te
lang drukken .

Omkeren van het ingangsignaal     :

De omgekeer functie laat toe om het signaal dat doorgegeven is door een sensor om te
keren. Deze functie is interessant  wanneer het  contact  van de sensor normaal  gezien
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gesloten is (NC).   

Deze functie is via het instellingenscherm van elke ingang-module van druk- of DISM0x-
type bereikbaar. 

DISM08     ; DISM04

Beschrijving

De module laat de directe aansluiting van de drukknoppen of van hele anderer ingangen,
sensoren, enz. vrij van potentieel toe.  

Witte draad Gemene draad

Bruine draad Ingang 1

Rode draad Ingang 2 

Oranje draad Ingang 3

Gele draad Ingang 4

Groene draad Ingang 5

Blauwe draad Ingang 6

Mauve draad Ingang 7

Grijze draad Ingang 8

Bewerking van de module

. Module parameter     :  Naam, Type, Versie en Adres van de module. Enkel de naam
van de module is bewerkbaar. 

.  Ingang parameter     :  Namen van de ingangskanalen,  2 functies en  omgekeerd.
(Beschrijving in de algemene informatie van het hoodstuk Ingang) 

DPBU01     ; DPBU02     ; DPBU04     ; DPBU06

Beschrijving

Drukknoppen met led. Reeks Bticino Light/Living. Er bestaan 4 module-types : 1, 2, 4, 6
drukknoppen met led. 

Led  programmeerbaar.  De  intensiteit  van  de  leds  worden  NIET  door  de  Domintell2-
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software beheerst.  

Bewerking van de module

. Module parameter     : Naam, Type, Versie en Adres van de module. Enkel de naam
is bewerkbaar. 

.  I/U  parameter     : Namen  van  de  ingangknoppen,  namen  van  de  leds  van  de
uitgangen,  2 functies en  Omgekeerd.  (beschrijving in de algemene informatie van het
hoodstuk Ingang)  

Extra informatie

DDIR01     ; DDIR02     ; DNIDIR01     ; DTDIR03     ; DAXDIR04

Beschrijving

Infrarode sensor die de signalen ontvangt van de IR afstandsbedieningen van Domintell of
van een universele infrarode afstandbediening. Deze module laat het ontcijferen van 32 IR
besturingskanalen  toe. 

Bewerking van de module

. Uitgang parameter   : Naam, Type, Versie en Adres van de module. Enkel de naam
is bewerkbaar. 
. Ingang parameter     : Naam van de IR-sensor.

DMOV01     ; DMOV02     ; DTMOV03     ; DAXMOV04

Beschrijving

Bewegingsensor  PIR.  Instelling  van  de  gevoeligheid  via  het  instellingensoftware.  Een
detectieled (rode led) kan tijdens de instelling al dan niet geactiveerd worden.  
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Bewerking van de module

. Module parameter     : Naam, Type, Versie en Adres van de module. Enkel de naam
van de module is bewerkbaar. 
. Ingang parameter     : Naam van de aanwezigheidssensor. Omgekeerd. (beschrijving
in  de  algemene  informatie),  beheer  van  de  detectiegevoeligheid.  Optionele
aansteking van de led van de module in het geval van een detectie, led aan tijdens
beweging.  

DPBLCD01     ; DAXPBLCD01     ; DPBLCD02     ; DAXPBLCD02

Beschrijving

Controle-touchscreen. Instelling van het aantal ingangen en uitgangen die gebruikt zijn in
het instellingensoftware. Mogelijke instellingen : 1, 2, 4 of 6 drukzones.  

PBLCD01  =  versie  zonder  geïntegreerde  temperatuursensor.  PBLCD02  =  versie  met
geïntegreerde temperatuursensor. 

Mogelijke  drukzones :  LCD  drukknop,  DAMPLI01  audiomenu,  airconditioning  menu,
DFAN01 airconditioning menu, DMV01 ventilatie menu, numerische uurwerk. 

Mogelijke stand-by schermen : digitale uurwerken, analogische uurwerken, weergave van
de temperatuur, gepersonaliseerde afbeelding.  

De  lichtintensiteit  van  de  achtergrondverlichting  wordt  door  het  Domintell2-software
beheerst. 

Mogelijkheid om gepersonaliseerde afbeeldingen met bmp-formaat (bitmap) te gebruiken
volgens  de  afmetingen  die  aangegeven  zijn  in  het  hoodstuk  Invoer  en  beheer  van
afbeeldingen in de bibliotheek. 

De programmatie van de klimaatregeling van de temperatuursensor van de PBLCD02 is in
het hoodstuk Algemene informatie : temperatuursensoren uitgelegd. 

Bewerking van de module

Bewerkt de PBLCD0x door rechts te klikken op één van de ingangs- of uigangselementen
van de module. 

Hoofdscherm van de instellingen
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De instelling van het aspect van de PBLCD0x voert zich via dit scherm uit : 

1) Keuze van het aantal knoppen die weergegeven moet worden

Het scherm beschikt over één, twee, vier of zes druk/weergave zones. Het zijn standaard
drukknoppen. Men kan ook in een drukknopzone kiezen voor een standaard digitale klok
of een temperatuur of audio icone.  

 

Als linken aanwezig zijn is het mogelijk dat sommige instellingen van knoppen niet meer
mogelijk  zijn.  Om  over  die  instellingen  te  beschikken,  moeten  er  linken  op  de
ingangen/uitgangen van de PBLCD0x verwijdert worden.  

2) Optie van de achtergrondverlichting

Er bestaan 3 functiemodes van achtergrondverlichting : Actief, Inactief (verandering van de
intensiteit na de bepaalde inactiviteitstijd) en Stand-by (wanneer het scherm inactief is, de
weergave van het stand-by scherm en de verandering van de intensiteit voeren zich na de
aangewezen tijd uit).  

Mogelijkheid om de lichtintensiteit van het scherm te wijzigen tijdens de overgang naar de
slaapstand. De gebruiker geeft zelf de tijdsblok aan (Gebruiker mode) of baseert zich op
het astronomische uurwerk. 

De optie  Directe actie laat een onmiddelijke reactie toe tijdens de druk op het scherm,
zonder het uitschakkelen van het stand-by scherm af te wachten. Dit optie is beschikbaar
via de versie 65 van het firmware van de PBLCD. 
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3) Stand-by scherm

De optie 'stand-by scherm gebruiken' schakkelt na een gegeven periode het ingestelde en
gekozen stand-by scherm in .: 

-  Analogisch  uurwerk :  het  uur  wordt  onder  de  vorm  van  een  wijzerklok
weergegeven. 

- Digitale uurwerk : het uur wordt onder de digitale vorm weergegeven.

-  Domintell  :  zwart scherm met een blauwe lijn en een kleine Domintell-logo zijn
weergegeven. 

– Gepersonaliseerd : afbeelding afkomstig van de bibliotheek. De afbeelding mag
niet meer dan 32.000 pixels (h*l) bevatten. De gewone maat is 200x150 pixels.
Het  is  mogelijk  om  « meer  uitgerokken »  afbeeldingen  in  te  voegen  met
inachtneming van de maximale grootte.

Invoer en beheer van afbeeldingen in de bibliotheek

De  afbeeldingen  die  gehanteerd  kunnen  worden  door  de  PBLCD-modules  moeten
sommige criteria van formaat en grootte respecteren. 

De afbeeldingen moeten absoluut onder het formaat *bmp (bitmap) 24 bits gebruikt
worden. 

Volgens  de  weergavezone  (stand-by  scherm  of  knop),  moeten  de  afmeetingen
gerespecteerd worden. De maximale grootte voor de PBLCD-modules is 32000 pixels. De
maximale breedte is 318 pixels en de maximale hoogte is 138 pixels. Het is onmmogelijk
om het hele scherm met één afbeelding te vullen.  

Configuratietype  Hoogte x Breedte

B1 238 x 318

B2-B4 118 x 158

B6 118 x 104

 Het  formaat  *.bmp  (bitmap)  24  bits  beheerst  de  doozichtigheid  niet.  Om  de  weergave
« vierkant » van een afbeelding te verwijderen en het snijden toe te laten, is het mogelijk om de
optie doorzichtigheid in het instellingengvenster van de PBLCD-module te kiezen. Dit behandeling
laat toe om niet alle pixels die dezelfde kleur hebben als de pixel linksbovenop de afbeelding weer
te geven. U moet een kleur kiezen die niet ergens anders op de afbeelding zal verschijnen. In het
onderstaande voorbeeld gaat het over de kleur magenta. 
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 →  → 

Het is mogelijk om afbeeldingen van uit bibliotheek van de PBLCD toe te voegen via het
menu Tools > Voeg afbeelding toe aan de PBLCD library. 

In het venster, klik op Import. Een input venster vraagt de plaats van de afbeelding. Kiez
het gewenste *.bmp (bitmap) bestand en klik op OK. Het programma plaatst het bestand
automatisch in de geschikte repertorium. Als de afbeelding te groot is, verschijnt er een
foutmelding.  Klik  op  bijvoegen  aan  repertorium  om  de  plaats  van  de  afbeelding  te
bevestigen.  Om een andere  afbeelding  in  te  voeren,  klik  opnieuw op  Import.  Om het
invoeren van de beelden te beeindigen , klik op OK. 

Het  beheer  van de bibliotheek
is via het menu Tools > PBLCD
behandeling  afbeelding
mogelijk. 

Dit  venster  laat  toe  om  het
afbeeldingenrepetorium van de
PBLCD  te  beheren.
Mogelijkheid om de bestanden
aanwezig in de repertorium van
het beheer van afbeeldingen te benoemen en te verwijderen. 

Verschillende schermen beschikbaar van de PBLCD

De PBLCD-modules  beschikken van  een instelling  van  1  à  6  drukzones,  gebruikt  als
tactiele drukknop of voor de weergave van de menu's. De menu's zijn beschikbaar als de
modules die verbonden zijn aan deze menu's aanwezig zijn in de applicatie. 

Om het  voorbeeld  van  de lezer  te  vergemakkelijken  zijn  de  drukzones,  die  hieronder
geîllustreerd  zijn,  gekleurd  geweest.  De  geelgekleurde  zones  op  de  verschillende
screenshots laten toe om terug te keren naar het hoofdmenu. 
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Hoofdmenu

Het hoofdmenu laat toe om linken van knoptype uit te voeren 
of de functies van de menu's te bereiken. 

Als een zone niet geconfigureerd is, is het aageraden om het 
uurwerk als knoptype te kiezen om onbedoelde drukken op 
deze zone van het scherm te vermijden.

Menu  Fan (enkel  met  PBLCD02  +  DFAN01)

Een DFAN01-module moet in de applicatie aanwezig zijn en
moet  verbonden  (regulering)  zijn  aan  de  sensor  van  de
PBLCD. 

Dit  menu  laat  het  beheer  van  de  regulering  DFAN01  toe.
Mogelijkheid  om  de  temperatuurmode  (auto,  afwezigheid,
comfort en  bevriezing)  te  veranderen ;  om  de  snelheid te
veranderen ; om de gewenste temperatuur te veranderen. 

Menu Temperatuur (enkel  met  DPBLCD02)

Laat het beheer van de temperatuur verbonden aan de sensor
van de module toe. Mogelijkheid om zowel de  mode van de
sensor (blauwe zone) als zijn vastgestelde temperatuur (rode
zone) te veranderen. 

Menu Geluid (enkel  als  DAMPLI01  aanwezig)

Laat  het  beheer  van  één  van  de  4  HP  uitgangen  van  de
DAMPLI01-module via tactiele zone toe. Dit menu laat toe om
het geluid en de audiobron te wijzigen. Het staat toe om in de
tuner gedeelte  de  zender te  wijzigen.  In  de  4  mogelijke
hulpgedeeltes laat het toe om IR codes (volgende en vorige) te
sturen  als  de  instelling  van  over  een  DIREMIT01-module
beschikt. 

Menu Ventilatie (enkel  als  DMV01  aanwezig)

Een  DMV01-module  (mechanische  gecontroleerde
airconditioning) moet in de applicatie aanwezig zijn. 

Dit  menu  laat  toe  om  één  van  de  3  snelheden  van
airconditioning van de DMV01 te kiezen. 
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DPBT01     ;  DPBT02     ;  DPBT04     ;  DPBT06     ;  DNKPB04     ;  DNKPB06     ;
DNIPB01     ; DNIPB02; DNIPB04; DNIPB06

Beschrijving

Drukknop met led. De rode en blauwe led zijn kleur per kleur dimbaar. De omtrek van de
knop gaat van de blauw naar de rood volgens de staat van de uitgang (volger functie).
Nachtbeheer laat het beheer van de intensiteit van de leds toe volgens de astronomische
klok  of  volgens  een  bepaalde  periode  door  de  gebruiker.  Knipperfunctie  van  de  leds
volgens een personaliseerbare periode.     

Bewerking van de module

. Module parameter     : Naam, Type, Versie en Adres van de module. Enkel de naam
kan berwerkt worden.  

.  U/I  parameter     : Namen  van de  ingangknoppen,  naam van de  uitgangleds,  2
functies en omgekeerd. (beschrijving in de algemene informatie van het hoodstuk Ingang)

. Beheer van de intensiteiten     : instelling van de intensiteit van de leds. Selectie van
het  mode  nachtbeheer.  Mode  inactief,  de  intensiteit blijft  in  dagmode.  Astronomische
mode,  de  intensiteitsverandering  dag-nacht voert  zich  volgens  de  zonsopgang  en
zonsondergang uit.  Mode instellingen  Gebruiker,  de verandering voert  zich volgens de
gewenste periode uit.   .

DIN10V02

Beschrijving

Ontvangstmodule  van  een  analogisch  signaal  van  een 0-10V ingang op  de BUS.  De
module is ingesteld met de hulp van de configuratie software als een ingang of als een
interface  op  een  temperatuursensor 0-10V.  De  afmetingsblok  is  in  maximum  100
waarden verdeeld. Aantal ingangen : 1.
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Bewerken van de module

. Parameter module     : Naam,  type, firmware versie en adres van de module. Enkel
de naam van de module kan bewerkt worden. 

.  Parameter : Naam  van de ingang 0-10V. Keuze van het gegevenstype 0-10V,
analogische gegevens of  temperatuurgegevens.  Beheer van de  werkingsblok door de
instelling van de  minimale en  maximale gemeten spanning. Venster van  omzetting van
afmetingen,  standaard  in  waarde  %.  Gegevens  verversen volgens  een  bepaalde
spanningsperiode of  spanningsverschil. 

DVIP01 & DVIP02

Beschrijving

Videofoon-module  geïntegreerd  aan  het  Domintell  domotica-systeem.  Audio-  en  video
overdrachtprotocol  onder  IP.  Toont  en  staat  in  contact  met  de  DTSC04-schermen.
Aanwezigheid van de O-LED  weergaveinstelllingen en van het  geluid in de Domintell
configuratie software. 
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Bewerken van de module

.  Algemene kenmerken : Naam,  type,  firmware  versie en  adres  van de module.
Enkel de naam van de module is bewerkbaar. .

.  Ingang     : Naam  van  de  ingangknop  DVIP01  (oproep),  naam van  de
besturingsfunctie van de deur. 

. Weergave     : Keuze van opstelling, tekstveld, soort aanpassing, overzicht van de
finale weergave. 

.  Connectie     : Keuze  van  de  mode  DHCP of  invoegen  van  een  vaste IP-adres.
Mogelijkheid om de connectieveranderingen onmiddelijk toe te passen door op de knop
Toepassen te drukken.  

. Geluid : Selectie van het geluidsniveau van de luidspreker. 

Extra informatie

Mogelijkheid  om over  de  statische  afbeelding  van  de videofoon te  beschikken  via  ftp
verzoek van deze vorm :

ftp://dvip0x_ip/di_screenshotd/

DPBR04

Beschrijving

Design  tactiele  drukknop  met  terugkoppelingsled.  Instelling  van  de  kleur  van  de
terugkoppelingsleds voor elke knop. Keuze van 16 miljoenen kleuren. Knipperen van de
leds mogelijk. Mogelijkheid om een bepaalde kleur tijdens een gebeurtenis te sturen. Een
geluidssignaal kan uitgezonden worden tijdens de druk.    
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Bewerken van de module

. Moduleparameter     : Naam, type, firmware versie et adres van de module. Enkel de
naam van de module is bewerkbaar. 

.  Ingangen     : Namen van de ingangknoppen, 2 functies, selectie van het geluid bij
druk.

.  Uitgangen     : Namen van de  uitgangenterugkoppelingsleds, selectie van de kleur
van de led « ON » en « OFF ». Door rechts te klikken, mogelijkheid om de kleuren van de
staten « ON » en « OFF » van de leds individueel te kiezen. Keuzelijst van de kleuren en
de waardenveld beschikbaar. Mogelijkheid om een kleurkeuze op  alle uitgangen van de
module of op alle knoppen (Bv. : elk eerste knop van de installatie) of alle knoppen van de
DPBR0x-modules aanwezig op de installatie.  

Instellen van de intensiteitenniveau's van de leds in dag en nacht periode. Selectie van de
beheermode inactief,  gebruiker  (verandering van intensiteit volgens de gekozen periode)
en astronomisch (verandering van intensiteit volgens de zonsopgang en zonsondergang).

DPBECO01     ; DPBECO02     ; DPBECO04     ; DPBECO06

Beschrijving

Design drukknoppen met terugkoppelingsleds. Unieke, rode en dimbare leds. 
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Bewerken van de module

. Moduleparameter     : Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden. 

.  Ingangen     : Namen  van  de ingangknoppen,  2 functies en  omgekeerd functie.
(Beschrijving in de algemene informatie in hoodstuk Ingang) 

. Uitgangen     : Naam van de uitgangleds. 

.  Intensiteitsbeheer     : instellen  van de intensiteitsniveau's  van de leds in  dag en
nacht periode. Selectie van de beheermode inactief, gebruiker (verandering van intensiteit
volgens de gekozen periode) en astronomisch (verandering van de intensiteit volgens de
zonsopgang en zonsondrgang). 

De DPBECO0x-gamma beschikt enkel over een rode, ON led.

DPULSE01

Beschrijving

Deze interface heeft  een drievoudige impulspulsteller die bv de monitoring toelaat van
bepaalde verbruiken . De 3 impulsingangen zijn instelbaar via de configuratie software.  

Bewerken van de module

.  DPULS01: Naam,  type,  firmwareversie en adres van de module. Enkel de naam van de
module is bewerkbaar.  

.  Configuratie: Naam van de geconnecteerd sensor, Type van verbruik, aantal  impulsen,
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Waarde van de impulsfmetingen, metingseenheid van het verbruik, tijdsschaal.

.  Combinatie  van de sensors     : Tools  voor  de  toevoeging/aftrekking  van  de  verzamelde
gegevens.  

.  Waarde     : leesoptie,  in  actie  PC mode,  van  de  opnamewaarden.  Mogelijkheid  om de
opgeslagen waarden te reseten.  

DPBL01     ; DPBL02     ; DPBL04

Beschrijving

Designe drukknop van de merk Lithoss. Module ontworpen uit de samenwerking tussen
Domintell en Lithoss. Leds instelbaar door knop met 8 mogelijke kleuren. Knipperen van
de leds mogelijk. Mogelijkheid om een precies kleur tijdens een gebeurtenis te sturen. 

Bewerken van de module

. Moduleparameter     : Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden. Enkel de naam van de module kan bewerkt
worden.

. Ingangen     : Naam van de ingangknoppen, 2 functies. 

. Uitgangen     :  Naam van de uitgangleds, selectie van de kleur van de leds « ON »
en « OFF ». Door rechts te klikken, mogelijkheid om de kleuren van de « ON » en « OFF »
staten van de leds individueel te kiezen. Keuze van 8 vastgestelde kleuren. Mogelijkheid
om de keuze van een kleur op alle uitgangen of op alle knoppen (Bv. : elk eerste knop van
de installatie) of op  alle knoppen van de DPBL0x-modules aanwezig in de applicatie te
dupliceren.  

Instellen van de intensiteitsniveau's van de leds in dag en nacht periode. Selectie van de
beheermode actief, gebruiker (verandering van de intensiteit volgens de gekozen periode)
en  astronomisch (verandering  van  de  intensiteit  volgens  de  zonsopgang  en
zonsondergang).

Handleiding van Domintell2 1.24 software   Updated op  18.09.2015  © Alle rechten voorbehouden aan Trump SA    www.domintell.com

34

http://www.domintell.com/


Uitgangen

Algemene informatie

De kolom rechts van het scherm toont de uitgangen aan. Ze voeren de domotische acties
uit.  

DBIR01

Beschrijving

Module  voorzien  van  8  bipolaire  relaisuitgangen.  Schakeloptie  van  de  relais  door
microschakelaars. Operationele functie wanneer het contact zonder potentieel gesloten is
(door een schakelaar of een directe connectie). Deze optie laat toe om de relais manueel
te  besturen  zonder  de  aanwezigheid  van  de  master.  Wanneer  de  microschakelaars
ingeschakelt zijn, kan de centrale eenheid van de domotica het  circuit niet meer besturen.

Mogelijkheid  om  de  tijdsduur  van  de  werking  van  de  verschillende  uitgangen te
raadplegen. Mogelijkheid om een theorische statisch verbruik te definiëren. 

Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

.  Parameter  uitgang     :  Naam van  de  Uitgangen.  Inschakelingstijdsduur  van  de
relais beschikbaar in  actief PC mode. Mogelijkheid om de werkingstijdsduur te reseten.
Theorische verbruikveld die het theorisch beheer van het verbruik toelaat.  

DDIM01

Beschrijving

Dimmer interface module (dimmer). Uitgangkaart voor de besturing van 1 tot 8 dimmers
van het type Ddxxx.  

Bewerken van de module

Klik rechts op één van de uitgangen van de DDIM01-module en kies de optie Bewerken
om in het instellingsvenster van de module te geraken. 
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 Klik op de horizontale pijlen om door de verschillende bereikbare menu's te scrollen.
Volgens de versie van de module kunnen sommige modules niet bereikbaar zijn. 

. Parameters van de module     :Naam, type, firmware versie en adres van de module.
Enkel de naam van de module kan bewerkt worden.

.  Uitgangsparameters     :  Naam  van  de  Uitgangen.  Geuheugenoptie  van  het
intensiteitsniveau van de dimmer voor zijn laatste uitschakeling (laatste waarde opslaan).
Mogelijkheid om de werkingstijdsduur van de uitgangen in te stellen. Optie van minimale
Waarde beschikbaar vanaf de firmwareversie 32. Mogelijkheid om een theorische statisch
verbruik. Vanaf de firmwareversie 34, beschikbaarheid van de Single Edge Mode voor de
controle van de DD10V- en DD400L-modules.  

DTRP01

Beschrijving

Teleruptor  module  voor  de  besturing  van  1  tot  4  teleruptors.  Indien  men manueel  de
teleruptors vomschakeld , volgt de domtica de stand van deze op. 

Bewerken van de module

. Parameters van  de module   :Naam, type, firmware versie en adres van de module.
Enkel de naam van de module kan bewerkt worden.

. Uitgangsparameters   :  Naam van de  Uitgangen.  Duurtijd van aankoppeling van
de  periferische  TL2001  telerutoren  in   PC  Actiieve  mode.  Mogelijkheid  van  terug  op
nulstelling  van  de  werkingstijd. Mogelijkheid  van  de  verschikllende  werkingstijden  van
deze uitgangen te bezichtigen. Mogelijkheid een theoretische instelling bij te voegen van
de verbruikers.
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DTRP02

Beschrijving

Invertor teleruptor module voor het besturen van motoren met twee richtingsrotaties . De
besturingsconfiguratie met 2 x2 invertor teleruptoren laat de schakeling toe van 2-weg
motoren . Indien men manueel  deze telerutoren schakelt zal de Master de statusen van
de kaarten actualisren . Er bestaat de mogelijkheid van de eindkoerstijd bijte stellen zowal
voor de stijfging als de daling .

Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

. UItgangsparameters     :  Naam van de  Uitgangen. Beheer van de eindkoerstijden.

DTRV01

Beschrijving

Module voor 4 motoren  230V, voor het besturen van motoren met twee rotatierichtingen.
(rolluiken, screens, projectieschermen,,zonnetenten , etc... Een dubbele connectie van van
potentiaal   laat  een manuele  commando toe  van het  stijgen en het  dalen   van de 4
uitgangen. De module is ook voorzien van ledjes die de stand van de relais van elke
uitgang aanwijzen. Het is ook mogelijk een Amerikaans -type  rolluik te besturen ( rolluik
met lamellen) ; Dit gebeurt via de puls mode .

Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

.  Uitgangsparameters     :  Naam  van  de  uitgangen..  Beheer  van  de
eindkoerstemporisatie.

  vanaf de versie 3 van de firmware van de DTRV01 module ,  zijn de stijging en
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dalingsparameterstijden slechts toegankelijk in het parameterles venster van de module
( rechter klik op één van de uitgangen van de module > optie Bewerken).

DTRVBT01

Beschrijving

DC (direct current)  rolluikmodule laag spanning (Max 24 Volt).  Voor het  betsturen van
motoren  met   dubbele  rotatierichting.  Men  gebruikt  de  verbruiksparameters  van  de
motoren om de gevoeligheid van de eoindkoers in te stellen. De duurtijd en retour van
eindkoers zijn programeerbaar..

Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

. Uitgangsparameters     :  Naam van de  Uitgangen. Beheer van de temporisatie van
de eindkoers.

.  Verbruiksparameters: Regeling van het vermogen en voedingsspanning van de
motor.  Beheer  van  de  stopgevoeligheid.  De  optie  Retour  van  de  einde-rolluikkoers  ,
ischakelt de motor om op het einde van de koers. Hiermede kan men de mechanische
spanning op de armaturen vrijwaren. In  PC actieve mode, directe Manuele  Commando
van de module.
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DLED01

Beschrijving

Module  met  4  terugmeldingsledjes  ,  geprogrameerd  in  functie  van  de  status  van  de
verbruiker of van de stuts van de applicatie of ook permanent aangelaten.

Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

. Uitgangsparameters :  Naam van de Uitgangen. 
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DOUT10V02

Beschrijving

Uitgansmodule  van  0/1-10v  direct  op  de  BUS.  Deze  module  laat  het  beheer  en  het
commando toe van toestellen die met een analoog signaal van 0 tot10 V of van  1 tot 10 V
zijn voorzien. Selectie van de modes :  0 - 10 Vdc en  1 - 10 Vdc in de parameters   E/S
instelling van de module.

Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

.  Parameter E/S     :  Naam van de  Uitgang.  Keuze van de mode 1-10V (Normale
mode : 0-10V), Beschikbaarheid van de  dimmermode. Indien men deze optie uitvinkt, is
het niet meer mogelijk een lange druk te gebruiken om de uitgang UT10V02  te bedienen
(Veiligheid gebruikt waneer de module een klimatische regulatie hanteert.). Optie van de
memorisatie van de laatste gebruikte waarde. In PC actieve mode is de optie uitleesbaar
van de duur van de schaketijd. Hier kan met ook de terug op nulstelling van deze tijd
herinbrengen.
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DMR01

Beschrijving

Monopolaire  relaismodule  met  5  uitgangen.  De  module  is  ook  voorzien  van
microschakelaars om de uitgangen in nood te kunnen besturen zonder het gebruik van de
Master. De module is voorzien van terugmeldingsledjes om de status van de relais weer te
geven  .  Er  bestaat  de  mogelijkheid  om  de  gebruiksduurtijd  van  de  uitgangen  te
raadplegen. Dit geeft de mogelijkheid om een theoretisch verbruik te definieëren.

Bewerken van de module

. Moduleparameter     : Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

.  UItgangsparameters     :  Naam van de  Uitgangen.  Werkings duurtijd  via  de  PC
actieve mode uitleesbaar.   Mogelijkheid  van de nulstelling  van deze parametersDurée
d'enclenchement des relais disponible en mode PC Actif. Possibilité de remise à zéro de la
durée de  fonctionnement.  Dit  geeft  de  mogelijkheid  om  een  theoretisch  verbruik  te
definieëren.
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DDMX01

Beschrijving

Master  interface voor  het  DMX512  protocol.  Deze module  is  een controler  voor  een
periferische  DMX (digital multiplexing).(voorbeeld, een strip-Led RGB verlichting) Laat  de
dimmerfunctie en het beheer toe van RGB Ledverlichting. Mogelijk aantal beheerde DMX
uitgangen per module : 64 (max 8 drivers DMX van 8 Uitgangen).

Bewerken van de module

. Moduleparameter     : Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

.  Uitgangsparameters   :  Aantal gebruikte kanalen (Max 8 kanalen per slave DMX
module). DMX adres van het eerste gebruikte kanaal door de geconfigureerde slave DMX.
configuré.  Naam van de slave DMX.  Configuratie van de kanalen van de slave DMX :
naam, type, ( rood, groen, blauw, en intensiteit  ).  Minimale waarde( Min) en maximale
waarde ( Max) gelegen tussen 0 en 255 .
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Extra informaties     :

De mogelijke kleurencyclusfunctie start altijd met de variatie van het Rode kanaal van de
DMX interface.

DINTDALI01

Beschrijving

Masterinterface voor  het  DALI protocol  (Digital  Adressable Lighting Interface).  Laat  de
dynamische controle toe van verlichting bestuurd en gekoppeld met een DALI interface.
Ondersteunt de dimmer functies. Capaciteit :   max 64 DALI apparaten per DINTDALI01
interface. DALI protocol compatibel vanaf versie 1.24.00 : Type 0 (Fluorescent Lamps) ;
Type 6 (LED). Automatische zoekfunctie DALI (gelijkend op Domintell scan). Beheerfunctie
van de DALI interfacen : Acces tot de interne regeling van de Dali parameters. Naargelang
de type aangesloten Dali apparaten heeft kan men de statistieken raadplegen.

Bewerken van de module

. Voornaamste venster: Naam, type, firmware versie en adres van de module. Enkel
de naam van de module kan bewerkt worden. Activatieknop van de scan en zoekfunctie.

.  Apparatenbeheer  DALI     :  Aanwezige module lijst, Nieuwe modules en afwezige
modules.

.  Automatische  zoekfunctie: Lijst,  parameters  en  caracteristieken  van  de
gedetecteerde DALI apparaten.  Naam,  Type DALI, EAN code, Serienummer (Serial #),
Versie, Adres (short addr.).
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Extra informaties

Men verkrijgt de acces naar de geavanceerde informatie en parameters door een rechter
klik op de naam van het DALI apparaat dat door de zoekfunctie werd gescand en zich in
de gevonden lijst bevindt. De modificatie van deze waarden moet door een proffesioneel
vakman  gebeuren  die  de  noodzakelijke  kennis  over  DALI  programmatie  bezit..  

DMV01

Beschrijving

Interfacemodule voor  mechanische ventilatie.  Functioneerd met  3  ventillatie  snelheden
voor de controle van  de meeste ventilatieapparaten met dubbele flux.  Drie uitgangen
controleren  de  ventillatiesnelheden  ,  2  uitgangen  blijven  dan  vrij  .  (  bv  laten  toe
verlichtingskringen te bedienen.)

Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

.  Uitgangsparameters     :  Naam  van  de  Uitgangen.  De  eerste  groep  van  3
monopolaire relais vormt de DMV01 uitgang. De tweede groep vormt de twee vrije relais.
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Displays

Algemene informatie
De displays bevatten de schermen van het algemeen beheer van de installatie.

DTSC02

Beschrijving

Kleuren TFT aanraakscherm. Laat toe om alle elementen op de bus te visualiseren en te
bedienen. Laat ook toe om de klimaatregeling, de uurwerken en de audio module aan
te passen en te regelen. Het scherm beschikt ook over een temperatuur sonde, een
infrarood ontvanger,  een micro SD kaart  lezer (µSD), een netwerk aansluiting een
schermvergrendeling met accescode. De achtergrondverlichting kan geregeld worden.
Het  uur  en  de  datum  kunnen  aangepast  worden.  Een  elektronisch  fotokader  is
ingebouwd.

Bewerken   van de module

. Hoofdscherm: Naam, type, firmware versie en adres van de module. Enkel de naam
van de module kan gewijzigd worden.
.  Ingangen: Namen van  de  4  Ingangen,  2  functies (Beschrijving  in  de  algemene
informatie van de Ingangen).
. Uitgangen: Namen van de terugmelding functies Uitgangen.

.  Configuratie IP: Keuze van het IP adres beheer voor de module. Beheer via DHCP
(Dynamic Host Configuration Protocol) Of via een vast IP adres.

.  Schermslot: Veld  met  de  naam en  keuze  van  de  accescode  via  een  4-cijferige
combinatie. Er kan maar 1 code ingegeven worden. Als de code 0000 is wordt er geen
klavier getoond om de code in te geven, bij  een andere code wel. Het schermslot
wordt dus automatisch geactiveerd als er een code anders dan 0000 wordt ingegeven.

Handleiding van Domintell2 1.24 software   Updated op  18.09.2015  © Alle rechten voorbehouden aan Trump SA    www.domintell.com

45

http://www.domintell.com/


Extra   informatie

Er  kan  een  screenshot  genomen  worden  via  http://<ip_van_de_dtsc>:17480.  Het
gegenereerde  beeld  wordt  automatisch  doorgezonden  naar
ftp://<ip_du_dtsc>/di_screenshotd/SCR_*.png

Om  het  IP  adres  van  de  module  te  kennen  kan  je  gebruik  maken  van  de  tools  die
meegeleverd zijn met de software: de GdethTester, het menu  ETH DIAGNOSTIC te
vinden op de master (DGQG01) of via het window om te flashen (Tools > Flasher >
Module’s Firmwares > Via Ethernet).

DTSC04

Beschrijving

Kleuren TFT aanraakscherm. Laat toe om alle elementen op de bus te visualiseren en te
bedienen. Laat ook toe om de klimaatregeling, de uurwerken en de audio module aan
te passen en te regelen. Het scherm beschikt ook over een temperatuur sonde, een
infrarood ontvanger,  een micro SD kaart  lezer (µSD), een netwerk aansluiting een
schermvergrendeling met accescode. De achtergrondverlichting kan geregeld worden.
Het  uur  en  de  datum  kunnen  aangepast  worden.  Een  elektronisch  fotokader  is
ingebouwd.

Mogelijkheid om op IP gebaseerde veiligheidscamera’s te visualiseren. Moet wel op het
hetzelfde netwerk zitten als het scherm. Mogelijkheid om naar AXIS IP camera’s te
zoeken.  Mogelijkheid  om manueel  IP camera’s  te  integreren.  Meer  info  :  Erreur  :
source de la référence non trouvée (p:Erreur : source de la référence non trouvée)

Bewerken   van de module

. Hoofdscherm: Naam, type, firmware versie en adres van de module. Enkel de naam
van de module kan gewijzigd worden.
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.  Ingangen: Namen van  de  4  Ingangen,  2  functies (Beschrijving  in  de  algemene
informatie van de Ingangen).
. Uitgangen: Namen van de terugmelding functies Uitgangen.

.  Configuratie IP: Keuze van het IP adres beheer voor de module. Beheer via DHCP
(Dynamic Host Configuration Protocol) Of via een vast IP adres.

.  Schermslot: Veld  met  de  naam en  keuze  van  de  accescode  via  een  4-cijferige
combinatie. Er kan maar 1 code ingegeven worden. Als de code 0000 is wordt er geen
klavier getoond om de code in te geven, bij  een andere code wel. Het schermslot
wordt dus automatisch geactiveerd als er een code anders dan 0000 wordt ingegeven.
. Volume: Regeling van het volume indien er een DVIP0x aanwezig is.
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Extra   informatie

Er  kan  een  screenshot  genomen  worden  via  http://<ip_van_de_dtsc>:17480.  Het
gegenereerde  beeld  wordt  automatisch  doorgezonden  naar
ftp://<ip_du_dtsc>/di_screenshotd/SCR_*.png

Om  het  IP  adres  van  de  module  te  kennen  kan  je  gebruik  maken  van  de  tools  die
meegeleverd zijn met de software: de GdethTester, het menu  ETH DIAGNOSTIC te
vinden op de master (DGQG01) of via het window om te flashen (Tools > Flasher >
Module’s Firmwares > Via Ethernet).

Communicatie

Algemene   informatie

DGSM01

Beschrijving

Communicatiemodule via SMS berichten. Laat toe om acties uit te voeren bij ontvangst
van een vooraf gedefinieerde SMS. Lijst van SMS berichten voor zowel het verzenden
als het ontvangen is definieerbaar. Via de ingebouwde batterij  kunnen zelfs nog bij
verlies van voeding alarmberichten verstuurd worden. Mogelijkheid om Sms’jes uit te
zenden indien de elektriciteit uitvalt en/of hersteld is. Diagnose tool om de status van
de DGSM01 uit te lezen. Mogelijkheid om SMS berichten naar 200 telefoonnummers
te sturen en van te ontvangen.

Bewerken   van de module

.  Algemene Opties: Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan gewijzigd worden.
. Status: In de mode master en PC actief geeft de knop Status de status van volgende
parameters  weer:  Niveau  van  de  Batterij,  Connectie  met  de  BUS,  Staat  van  het
Opladen van de batterij, de  temperatuur van de module, detectie van de  SIM kaart,
staat van de bewaking van de DGSM01, Initialisatie van de DGSM01, Validatie van de
PIN  code. Menu  PUK Code. Na 3 mislukte pogingen om de PIN code in te voeren
blokkeert de SIM kaart. Het is dan nodig om de PUK code in te voeren om de kaart te
deblokkeren.
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. Ingang/uitgang Parameters: Namen van de ingangen en de uitgangen.

. Bericht Verzenden: Laat toe om een gepersonaliseerd bericht te sturen bij wegvallen
van de voeding en/of terug opkomen ervan. Deze boodschappen kunnen maar naar
één nummer verstuurd worden, het alarmnummer.

.  GSM Opties: Veld om de  PIN code in  te  brengen.  Gebruik  altijd  een PIN code.
Gebruik niet de code 0000, hij wordt gebruikt om een niet gedigitaliseerde SIM aan te
duiden. Nr Berichtencentrum: Om het nummer van de gekozen operator te weten, zie
de PRO website of contacteer de operator rechtstreeks.
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Extra informatie

.   Configuratie via de Domintell2 software

Bij het in gebruik stellen moet de interne batterij van de module gedurende ten minste drie
uur opladen om tekstberichten te kunnen sturen.

Daarna kan je de SIM kaart insteken.

Start  “net scannen”,  de DGSM01 module komt zowel  in ingangen als in de uitgangen
kolom te staan. Vanaf nu kan je al berichten sturen en ontvangen.

Klik met de rechter muistoets op het icoon van de module (naar keuze op de ingangen of
de uitgangen kolom). Daarna bewerken selecteren.

Een pop-up window verschijnt.

Breng  naar  keuze  de  tekst  in  om  te  versturen  bij  verlies  van  voeding  en/of  bij  het
terugkomen ervan.

Breng het nummer in waar in geval van alarm een SMS moet naartoe gestuurd worden
(vb. +32487326101).

Breng  het  nummer  in  van  de  berichtencentrale  van  de  operator.  De  lijst
(SMS_Message_Service_2008.pdf) is beschikbaar op de PRO website van Domintell.

Proximus: +32475161616 Base: +32486000005 Mobistar: +32495002530

Alle  nummers  moeten  in  de  internationale  standaard  ingegeven  worden:
+_landcode_nummer (het “_” teken niet ingeven!).

Breng de PIN code in van de SIM kaart, geen 0000 ingeven!

Verstuur bestand naar de master (Toepassing Versturen).

Als de toepassing verstuurd is dan pas de SIM kaart in de DGSM01 module inbrengen.

Controleer de status van de GSM module.

. Andere:

Het bijladen van een prepaid kaart kan niet met de Domintell2 software gedaan worden,
daarvoor gebruik je best een ander GSM toestel.

DRS23201

Beschrijving

Interface module voor het RS232 protocol, kan als ingang en uitgang gebruikt worden.
Wordt  gebruikt  om  te  communiceren  met  bijvoorbeeld  alarmsystemen,  audio
systemen, airco systemen, enz. Aansluiten gebeurt via een vrouwelijke DB9 conrector.
Centraal tekstbestand om boodschappen te sturen en te ontvangen zit in Domintell2.
Mogelijkheid om speciale leestekens te gebruiken.

Bewerken   van de module
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De  overdrachtssnelheid  (Baudrate)  en  de  pariteit  moeten  geselecteerd  worden.  De
uitgebreide mode laat toe om in hexadecimaal de eerste 32 niet-leesbare leestekens
te versturen en te ontvangen.

Extra   informatie  : 

De DRS23201 module ondersteunt maar één verbinding tezelfdertijd. Heeft het andere
systeem  meerdere  interfaces  dan  moeten  meerdere  DRS23201  modules
geconfigureerd worden.

 Voorbeeld van een verbinding : bij inbraak gedetecteerd door een alarmcentrale kunnen
alle lichten in huis aangestoken worden.

Algemene informatie over de DETH0x

Vooraleer de eerste keer een DETH0x module te gebruiken raden we aan om de eerste
toepassing  via  de  USB poort  van  de  master  (DGQG01)  te  versturen.  Deze  USB
verbinding laat toe om de configuratie van de DETH0x module te doen.

Algemene   parameters

Toegang tot de parameters wordt verkregen door de module te selecteren in Domintell2 en
bewerken te kiezen.

Parameters voor   de   verbinding

Als het vakje Gebruik DHCP aangevinkt is krijgt de module
een  IP  adres  via  een  DHCP  server.  Indien  niet
aangevinkt wordt er een statisch IP adres gebruikt. In
het “Poort zoeken” veld wordt het nummer van de poort
gespecificeerd waarmee er contact gemaakt wordt. De
default  waarde  is  17481. Het  is  aan  te  raden  om
nummers hoger dan 1024 te gebruiken.

Sessie parameters

Per  default  is  de  module  geconfigureerd  als  exclusieve
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sessie. Als er een sessie geopend is moet deze eerst
gesloten worden om een nieuwe sessie via een andere
computer tot stand te kunnen brengen. Staat dit vakje
niet  aangevinkt  dan  kan  iedereen  de  controle
overnemen  waardoor  de  bestaande  sessie
automatisch  afgebroken  wordt.  Bij  een  exclusieve
sessie hoort steeds een sessie time-out om te kunnen
aangeven  hoelang  deze  sessie  moet  geldig  blijven.
Indien  er  gedurende  de  gespecificeerde  tijd  geen
communicatie is wordt de sessie afgebroken en komt
zo vrij voor een andere.

NTP   configuratie

Het  NTP (Network Time Protocol) protocol laat toe om de
tijd  automatisch  correct  in  te  stellen.  Alle  DETH0x
modules  hebben  deze  functionaliteit,  deze  vervangt
dus  de  DDCF01 module  (gebruikte  de  atoomklok  in
Frankfurt om de tijd te synchroniseren). De optie NTP
aanvinken vereist een internet connectie om te kunnen
werken.  Ieder  ochtend om 3u wordt  de  klok  van  de
master  gesynchroniseerd.  Het  adres  van  de  NTP
bediener moet  verplicht  een  IP adres  zijn.  De  knop
Zoek NTP bediener laat toe om automatisch te zoeken
naar een NTP server en om de Overgang (Gateway)
correct  in  te  stellen  (de  NTP  server  wordt  uit  de
Windows configuratie gehaald).

De knop Zoek NTP bediener laat toe om automatisch naar
het IP adres te zoeken naar een NTP server waarvan
de URL gekend is.

De aanduiding van het uur en datum evenals de overgang
van winter naar zomertijd (indien deze geactiveerd is in
Tools->Automatische zomer/winteruur verandering)
wordt  uit  de  Windows configuratie  gehaald  en wordt
door Master aangepast.

Volgende parameters

Het Mac adres enkel aanpassen als er dubbele adressen
aanwezig zijn.

Het Mac adres is enkel in de module zelf opgeslagen.
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Het is mogelijk  en aan te raden om een paswoord in te
geven bij opening van een sessie. Het paswoord zelf
wordt enkel in de module opgeslagen, nergens anders.

DETH03

Beschrijving

Ethernet  communicatie  interface.  Verbinding  tussen  de  domotica  BUS  en  het  lokale
netwerk (LAN). Configureerbaar met een dynamisch IP adres (DHCP) of een vast.
Optie om een exclusieve sessie te openen en de duur ervan. Mogelijkheid om de tijd
via een NTP server (Network Time Protocol) automatisch juist te zetten, een internet
connectie is vereist. Mogelijkheid om een paswoord in te stellen. Mogelijkheid om het
MAC adres aan te passen indien nodig. 

Informatie over  de configuratie  is te vinden in  punt  Algemene  informatie  over  de
DETH0x(p51)

Extra   informatie

Om  het  IP  adres  van  de  module  te  kennen  kan  je  gebruik  maken  van  de  tools  die
meegeleverd zijn met de software: de GdethTester of via het menu ETH DIAGNOSTIC
te vinden op de master (DGQG01).
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Temperatuur

Algemene informatie     : temperatuur sonde

De Domintell sondes kunnen verschillende profielen hebben voor zowel verwarming als
koeling. Deze zijn volledig configureerbaar.

Om deze regeling naar behoren te laten werken moet elke sonde juist  geconfigureerd
worden.

     Basis parameter

 

 Compensatie   :

De temperatuur sondes zijn niet gekalibreerd in de fabriek. De kalibratie moet gebeuren
tijdens het instellen van het systeem. Met de hulp van een standaard thermometer kan je
de temperatuur meten in de buurt van de sonde. Voer het verschil in tussen de gemeten
waarde van de referentiethermometer en de waarde doorgegeven van de Domintell sonde
(deze waarde kan je zien in de master en PC actief mode).

 Hystérésis:

Deze waarde wordt gebruikt bij een regeling alles of niets. Deze kan voor elke sonde 
afzonderlijk ingesteld worden. Meer info : Regelingstype (p124)

 Afwezigheid T° (verwarming en koeling):

Deze waardes zullen gebruikt worden in de temperatuur mode afwezig.  Meer info :
Regelingstype (p124)
opmerking : deze ingestelde temperaturen zijn identiek voor alles sondes.

     Opdracht aanpassing : 

 

Beperking van de gewenste waarden (voor verwarming en koeling) op de  verschillende
schermen (PBLCD02/DTSC02/DTSC04). De handmatige regeling kan nooit deze waarden
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overschrijden.

 Incrementeel waardepunt:

Deze waarde specifieert de stap grote voor het instellen van de temperatuur bij de 
manuele regeling.
Deze waarde is geldig voor alles sondes.
In de mode Afwezig en Vries kan de waarde niet ingesteld worden.

     Toon Temp. Mode  & Toon Reg. mode: 

Hier kan men de verschillende temperatuur modes aanvinken die beschikbaar zullen zijn
op de schermen (DTSC02 / DTSC04/ DPBLCD02) (automatisch, Comfort, Afwezig, Vries).
Bij  Toon  Reg.  Mode kan  men  de  verschillende  mogelijke  regelingen  aanvinken  die
zichtbaar zullen zijn op de schermen (gemengd, koeling, verwarming, off)

DTEM01

     Beschrijving

Temperatuursensor  module.  Deze module  stuurt  elke  minuut  de  gemeten temperatuur
naar de master. Er kan een uitgang mee aangestuurd worden afhankelijk van de gemeten
temperatuur. Beheer van acties door logische testen afhankelijk van de temperatuur mode
(automatisch,  afwezig,  comfort,  vries)  of  een  regeling  mode  (gemengd,  verwarming,
koeling, off)

     Bewerken van de module

. Zie hoofdstuk : Algemene informatie : temperatuur sonde (p54)
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De parameters voor  temperatuur en regel mode worden ingesteld in Domintell2 software.
Meer info : Regelingstype (p124)

DFAN01

     Beschrijving

Module voor het sturen van ventilatie units van het type FAN COIL. Drie relais controleren 
de snelheid van de ventilator. Twee relais controleren de vraag voor verwarming of 
koeling. Deze module moet samen geïnstalleerd worden met een temperatuur sonde van 
Domintell. Er bestaat de mogelijkheid van het aanschakelen van de Offset snelheden aan 
te passen. Zie  Menu activatie van de koeling/verwarming . 
Deze test mode is enkel mogelijk in de PC actief mode.

Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

. Parameter uitgang: Aanschakel waarde van de Offset snelheden van de ventilatie.

.  Activeer  afkoeling/verwarming     :  Mogelijkheid  voor  het  valideren  van  de
verschillende temperatuur modes voor de regeling verwarming en koeling.

     Extra informaties

De parameters voor  temperatuur en regel mode worden ingesteld in Domintell2 software. 
Meer info : Regelingstype (p124). 
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Diverse modules

DRS23202

     Beschrijving

RS232  Interface  light  protocol.  Interface  module  tussen  de  Domintell  bus  en  een  bi-
directionele  RS232.  Deze  module  laat  toe  een  verbinding  te  maken  met  externe
apparaten. Via het  light protocol is het mogelijk om commando’s in beide richtingen te
versturen. De module is uitgerust met een vrouwelijke DB9 connector. Beschrijving van het
light protocol is beschikbaar op aanvraag.

     Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.
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     Extra informatie

De snelheid van verzenden van gegevens ligt vast op 57.600 Baud (Baud rate) zonder
pariteit.

Deze module is bedoeld om installateurs de mogelijkheid te geven om een interface te
maken  tussen  de  Domintell  installatie  en  andere  apparatuur  .  Deze  module  kan
gepersonaliseerde  tekstboodschappen  ontvangen  (zoals  de  DRS23201)  maar  niet
verzenden. (enkel light protocol verzenden)

DRS23203 (B&O)

     Beschrijving

Deze module is een interface voor apparatuur van Bang & Olufsen via de master link
gateway (MLGW) van B&O. Deze module kan commando’s door sturen naar de MLGW
module via de RS232 poort. De DRS23203 maakt automatisch een lijst van commando’s
aan afhankelijk van het adres van de master link module van de B&O installatie.

     Bewerken van de module

. Moduleparameter     :Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.
De snelheid voor het versturen van de gegevens moet ingesteld worden (Baud rate en
pariteit).
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DAMPLI01

     Beschrijving

Multi-room audio versterker. Deze module laat toe om vier audio bronnen te verbinden aan
vier audio  zones.  De bronnen kunnen onafhankelijke audio toestellen zijn zoals een CD
speler of bijvoorbeeld een MP3 speler. In de module zijn ook 4 onafhankelijke analoge
tuners geïntegreerd. De DAMPLI01 beschikt over 4 paar uitgangen voor luidsprekers. (8
Ohm). Het vermogen van elke versterkers is 20 Watt RMS stereo.

     Bewerken van de module

. Parameterkaart :  Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

.   Aux ingangen: De Aux ingang kan hier geactiveerd worden. Men kan hier ook een
naam geven aan elk van de vier Aux ingangen.

. Toegekende IR uitgang: Indien er zowel een DIREMIT01 module aanwezig is als
een scherm (waar de selectie mogelijk is voor het audio menu), kan de uitgang van de
DIREMIT01 het toestel aansturen dat aangesloten is op de Aux ingang van de versterker
(via IR).

 Voorbeeld  :  Het  beheer  van  de  audio  van  een  kamer  gebeurt  via  een  aanraakscherm
DPBTLCD0X. Van zodra men de bron CD aanraakt is het mogelijk om IR codes te versturen naar
de CD speler.

. Paramater uitgang     : naam van de aangesloten luidsprekers, maximum volume per
kanaal, keuze van de zendergroep per kanaal, aanpassing van de balans per kanaal.
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     Extra informatie

Elke uitgang kan onafhankelijk van elkaar de verschillende ingangen selecteren. Het is
mogelijk in de keuken naar een CD te luisteren in op de slaapkamer bijvoorbeeld naar de
radio. Eens de radio geselecteerd is kan men een pre-selectie kiezen of een frequentie
instellen.

Deze module kan aangestuurd worden door alle type van ingangen(druktoetsen, horloges,
afstandsbediening enz.) Via het aanmaken van de link tussen ingang en uitgangen van de
module kan men kiezen welke actie er moet uitgevoerd worden.

Het kiezen van de bronnen is ook mogelijk via het Touch Screen. Het is mogelijk de  bron
te kiezen en het volume in te stellen (ook de zender kan gekozen worden op het scherm
als de radio als bron gebruikt wordt).

  Om  alle  commando’s  te  tonen  die  beschikbaar  zijn  voor  de  DAMPL01  is  het
aangeraden een Touch Screen van Domintell te gebruiken. Het is ook mogelijk de module
aan te sturen met de smart Phone of tablet.

     Selecteren van de radiostations :

Via de menu Project > Beheer van de radio, is het mogelijk de verschillende favoriete
radiostations te selecteren.

Het is mogelijk om de radiostations te scannen voor ze op te slaan in de database.

Creëren van een lijst radiostations :

. Handmatig opzoeken : (Mode Master alleen en mode Master en PC actief)

Indien u de frequentie kent van het radiostation dat u wenst bij te voegen is het mogelijk
deze rechtstreeks in te geven zonder te zoeken.
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Geef de Frequentie en de Naam van het station in. De frequentie kan ingegeven worden 
met zowel een komma als een punt 100.6 of 100,6. 

De knop Set laat toe om de ingegeven frequentie meteen te testen op de audiomodule. 
(enkel indien de master in  mode Master en PC actief is)

Door op Bijvoegen te klikken wordt het radiostation bijgevoegd aan de database

.

. Automatisch zoeken: (Mode Master autonome PC actif)

Het automatisch opzoeken werkt enkel in  Master en PC actief mode.

Procedure voor het vastleggen van radiostations:

1. Selecteer de audio uitgang die fysiek het dichtst bij u is via de knoppen HP1, HP2,
HP3 of HP4.

2. Zet het volume  via de schuifbalk.

3. Start het opzoeken door op pijlen te drukken  of . Via de knop Gevoeligheid
kan je de kwaliteit van het te ontvangen station aanpassen.

4. Van zodra er een station is gevonden wordt de frequentie getoond in het vakje
Frequentie.

5. Geef vervolgens een naam aan het gevonden station in het veldje Naam.

6. Voeg dit station dan bij in de database door op Bijvoegen te drukken.

7. Herhaal stap 3 tot 5 totdat alle gewenste radiostations gevonden zijn.

De opgeslagen stations bevinden zich rechts van het venster.

Indien gewenst kunnen de naam en de frequentie van het station terug aangepast worden
door er op te klikken en ze dan bij Handmatig zoeken te veranderen.

Om een station te verwijderen : met de cursor op het te verwijderen station, rechtermuis
toets en dan Weglaten selecteren.
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. Definitie van zendergroepen :

Om het aantal radiostations per versterker te beperken is het mogelijk een zendergroep te
maken en deze te linken aan een uitgang van de versterker. De acties volgende en vorige
hebben dan alleen effect op de zender die behoren tot de gelinkte zendergroep.

Te volgen werkwijze : 

1. Menu Project => Zendergroepen.

2. Klik in het midden van het venster met rechtermuistoets en selecteer bijvoegen. 

3. Geef een naam aan de zendergroep.

4. De  vooraf  ingesteld  radiostation  kunnen  nu  geselecteerd  of  gedeselecteerd
worden..

5. Klok op OK om te valideren.

Deze aangemaakte groepen kunnen toegewezen worden aan bepaalde uitgangen van de
module. Het is steeds mogelijk deze groepen te wijzigen. Ze kunnen enkel gewist worden
als ze niet toegewezen zijn aan een uitgang.

DIREMIT01

     Beschrijving

De module DIREMIT01 is een universele infrarood afstandsbediening. Zijn 3 IR uitgangen
kunnen IR codes verzenden naar een IR ontvanger van bijvoorbeeld een TV, CD speler
enz. De module heeft een IR ingang voor het aanleren van IR codes.

     Bewerken van de module
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. Paramater kaart: Naam, type, firmware versie en adres van de module. Enkel de
naam van de module kan bewerkt worden.

. Parameter I/U:  Namen van de IR zenders, Beheer IR Code opent het venster om
IR codes te beheren. 

.  Beheer  IR  Code: Het  linker  gedeelte  toont  de  verschillende  IR  uitgangen.
Selecteer de gewenste IR uitgang. Het rechter gedeelte toont de karakteristieken van de
IR codes (Naam, toestel, Actie) en het venster om de codes aan te leren.

Het aanleren van nieuwe IR codes kan gebeuren met een afstandsbediening van
het apparaat (bijvoorbeeld CD speler) en de IR ontvanger op de module. 

Handleiding van Domintell2 1.24 software   Updated op  18.09.2015  © Alle rechten voorbehouden aan Trump SA    www.domintell.com

63

http://www.domintell.com/


te volgen werkwijze : 

1. Kies de naam van een IR zender in het linker venster. Geef ook een naam en kies
het type toestel en de actie van de aan te leren code (rechter kant van het venster)

2. Druk  op  de  knop  Aanleren,  wijs  met  de  afstandsbediening  naar  de  ontvanger
(TEACH)  en  druk  op  de  toets  van  de  afstandsbediening  die  moet  opgeslagen
worden. Er zal een code verschijnen in het rechter venster. Met de knop Bijvoegen
kan deze code opgeslagen worden in de database.

3. Er is de mogelijkheid om deze code te testen vanaf het scherm Beheer IR Code:
Druk op code transfers  en vervolgens met de rechtermuis toets op de bijgevoegde
code en dan drukken op  testen. De IR zender moet wijzen naar het te bedienen
apparaat.

4. Van zodra alle codes aangeleerd zijn kan het venster  Beheer IR Code gesloten
worden.  Deze  codes  zullen  verstuurd  worden  naar  de  module  DIREMIT01  van
zodra de toepassing verstuurd wordt naar de master.

 Gebruik van de IR bibliotheek 

Toegang  tot  de  bibliotheek  van  de  codes  via  de  menu  Tools  >  IR  Database.
Deze tool stelt  u in staat uw IR codes te beheren zonder ze opnieuw aan te leren bij
gebruik van een andere DIREMIT01 module.

Te volgen werkwijze:

1. Maak en nieuwe bibliotheek door op Nieuw (links bovenaan) te drukken. Geef een
naam aan deze bibliotheek.
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2. Kies in het linker deel het toestel, Fabrikant en de actie + geef ook een naam voor
de gewenste actie.  Automatische naam kan afgevinkt worden zodat de naam niet
automatische gekozen zal worden.

3. Druk  op  de  knop  Aanleren,  wijs  met  de  afstandsbediening  naar  de  ontvanger
(TEACH)  en  druk  op  de  toets  van  de  afstandsbediening  die  moet  opgeslagen
worden. Er zal een code verschijnen in het rechter venster. Met de knop Bijvoegen
kan deze code opgeslagen worden in de database

4. Als alle codes zijn aangeleerd, druk op OK.

5. Deze codes zijn nu beschikbaar bij  Beheer IR Code (bij uitgangen, bewerken van
de IR zender). Om deze codes te selecteren, klik op IR database (rechts bovenaan)
en drag & drop de codes naar de te gebruiken IR zender. 

 Kopij van de IR bibliotheek 

Een bestand *.txt wordt automatisch aangemaakt bij het installeren van het programma
Domintell2 (C:\Program Files\Trump\Domintell2\Ir database). Dit laat toe de aangeleerde
codes te hergebruiken in andere Domintell configuraties. Dit laat ook toe om meerdere
bibliotheken te beheren (bijvoorbeeld per merk van een type apparaat).

Om  een  bibliotheek  te  importeren  in  het  scherm  IR  code  database  (Tools  >  IR
Database), druk op Import en kies de gewenste bibliotheek en druk op OK.

 

     Extra informatie:

Indien een uitgang van de DIREMIT01 module gekoppeld wordt aan de audio module
DAMPLI01  (Toegekende  IR  uitgang)  moeten de  basis  acties  (play,  pause,  volgende)
gedefinieerd zijn. Meer info : Toegekende IR uitgang: (p59)
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DETH02

     Beschrijving

Ethernet interface module met ‘light protocol”. Deze module laat toe om te communiceren
met een smart Phone of een tablet, een PC of een Touch screen van een ander merk dan
Domintell.  Communicatie  met  andere  domotica  systemen  is  ook  mogelijk  via  deze
interface.

De module kent het light protocol om te communiceren tussen de Domintell installatie en
een ander toestel.  De status van het systeem (status uitgangen en ingangen) zal  ook
teruggestuurd  worden  via  deze  interface.  Een  beschrijving  van  het  light  protocol is
beschikbaar op aanvraag.

Er is de mogelijkheid om een dynamisch IP adres te gebruiken (DHCP) of een vast IP
adres. Er is ook de mogelijkheid om sessie time-out in te stellen. Via NTP (Network Time
Protocol)  kan  het  juiste  uur  ingesteld  worden  op  de  master  (internet  connectie
noodzakelijk). Er is ook de mogelijkheid voor het instellen van een wachtwoord. Indien
nodig kan ook een deel van het MAC adres aangepast worden in de module. 
Meer info : Algemene informatie over de DETH0x(p51)

Extra informatie

Er is een library (Windows/Linux) beschikbaar voor het versleutelen van een paswoord.

De configuratie van deze module moet uitgevoerd worden door iemand met goede kennis
van IP netwerken. 

Om het IP adres te kennen van de module is het mogelijk de diagnose tools te gebruiken
die  meegeleverd  worden  met  de  software.  (GdethTester)  ofwel  via  de  menu  ETH
DIAGNOSTIC beschikbaar via de druktoetsen van de master.
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Modules niet meer ondersteund in versie 1.24.xx

Algemene informatie

In  deze  rubriek  worden  een  aantal  modules  beschreven  die  niet  meer  ondersteund
worden vanaf versie 1.24.xx. Het is mogelijk dat deze modules vanaf deze versie niet
meer of maar deels functioneren. Deze informatie is speciale voor de 

This information concerns specifically the module interconnection with the last Domintell's
modules.

Deze informatie betreft specifieke de module interconnectie met de laatste modules van
Domintell.
Voor meer informatie gelieve Domintell te contacteren. 

Handleiding van Domintell2 1.24 software   Updated op  18.09.2015  © Alle rechten voorbehouden aan Trump SA    www.domintell.com

67

http://www.domintell.com/


DTSC01      

     Beschrijving

Monochroom  aanraakscherm  dat  de  domotica  installatie  kan  visualiseren  (status
uitgangen) en toelaat de installatie te besturen. Het is ook mogelijk  de temperatuur te
beheren, de ingestelde klokken aan te passen, SMS, geluid enz. te beheren. Er is ook een
temperatuur sonde geïntegreerd en een IR ontvanger met 32 kanalen.

DTSC03

     Beschrijving

Kleuren aanraakscherm dat de domotica installatie kan visualiseren (status uitgangen) en
toelaat  de  installatie  te  besturen.  Het  is  ook  mogelijk  de  temperatuur  te  beheren,  de
ingestelde klokken aan te passen, SMS, geluid enz. te beheren. Er is ook een temperatuur
sonde geïntegreerd en een IR ontvanger met 32 kanalen.

DLCD02

     Beschrijving

LCD module die toelaat de status van uitgangen te bekijken alsook de gemeten waarde
van  de  temperatuursondes.  Het  is  ook  mogelijk  de  uitgangen  te  sturen  en  enkele
parameters te wijzigen. Er zijn 6 drukknoppen waarvan er 2 vrij zijn om te programmeren.

DLCD03

     Beschrijving

LCD module – temperatuur en geluid.

LCD module die toelaat de status van uitgangen te bekijken alsook de gemeten waarde
van de temperatuursondes.  Deze module is  ook uitgerust  met  een eigen temperatuur
sonde. Het is ook mogelijk de uitgangen te sturen en enkele parameters te wijzigen. Er zijn
6 drukknoppen waarvan er 5 vrij zijn om te programmeren.

DUSB01

     Beschrijving

Interface module tussen Domintell Bus en een USB poort. Deze module laat de verbinding
toe met externe toestellen via een USB bus. De data die kan ontvangen of verstuurd
worden zijn eenvoudige tekst boodschappen.
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DTEM02

     Beschrijving

Thermostaat module. Deze module laat  toe een uitgang te sturen afhankelijk  van een
vooraf  ingestelde  temperatuur.  Via  twee  geïntegreerde  toetsen  kan  men  de  mode
aanpassen : automatisch, comfort, afwezig of vorst.

DDCF77

     Beschrijving

DCF interface.  Deze  module  zal  elke  minuut  het  juiste  uur  ontvangen  van  een  DCF
atoomklok  in  Frankfurt.  (DCF77)  De  horloge  van  de  master  zal  hiermee  gelijk  gezet
worden. (klok kan ook gelijkgezet worden kan ook via NTP protocol met een deth02 of
deth03 module).

DGRAFINT01

     Beschrijving

USB  interface  +  grafische  software  “Visual  Domintell”.  Deze  module  laat  toe  om  de
statussen te controleren en aan te sturen van een Domintell installatie in samenwerking
met  de  “Visual  Domintell”  software”  Grafische support  voor  een Touch screen via  het
importeren van JPG, BMP enz. beelden . Deze module is gelijkaardig aan de DETH04
module.

DETH04

     Beschrijving

Ethernet interface + grafische software “Visual Domintell”. Deze module is gelijkaardig aan
de DGRAFINT01 module. Ze laat toe het programma “Visual Domintell” aan te sturen via
een ethernet verbinding.

DETH07

     Beschrijving

Bi-directionele ethernet Interface voor de Philips Pronto afstandsbediening. Indien deze
module aangesloten wordt aan een Wi-Fi router kan met via de Pronto afstandsbediening
van Philips de Domintell installatie aansturen.
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De linken

Basisactie

Het programmatieprincipe onder Domintell2 is het  slepen-loslaten. Het bestaat erin een
element  uit  de  uitgangkolom  (rechts  van  het  scherm)  uit  te  kiezen  en  het  in  de
ingangkolom (links  van het  scherm)  aan een ingang te  linken.  Een link  verenigt  een
ingang aan een  uitgang en  schept  een specifieke  actie  tussen die  twee domotische
componenten.

Neem Sleep Loslaten Kies een gebeurtenis

 Sinds de 1.16.xx-versie worden de  slepen-loslaten verplaatsingen in de Domintell2-
programma altijd van de rechtse kolom naar de linkse kolom gedaan. 

Procedure voor de schepping van een Domintell-link :

1. Kies een component in de uitgangkolom. 

2. Houd de linkse knop van de muis in. 

3. Verplaats de uitgekozen  component naar een Ingangcomponent. 

4. Laat de knop van de muis los wanneer de  uitgangcomponent  op de gewenste
ingangcomponent staat.

Als de link onmogelijjk is, verschijnt er een verbodteken naast de gekozen component.
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5. Bij  het  loslaten  van  de  knop  van  de  muis,  ontwtaat  er  een  dialoogbox  die  de
configuratie van de link mogelijk maakt.

Instelling van de linken

Een dialoogbox verschijnt op het einde van de  Slepen-Loslaten behandeling. De opties
van de dialoogbox hangen af van de technische kenmerken van de Ingang-module en de
Uitgang-module die opgenomen zijn in deze link .

Bijvoorbeeld deze dialoogbox die verschijnt na een link tussen een schakelmodule (Bv. :
DPBT02-LG)  en een relaismodule  (DBIR01).  Het  neemt  alle  instellingen over  die  van
toepassing zijn op de aangemaakte link. 

Druktypes op de   Ingang  -module

Deze instelling schakelt de uitgang van de link op een korte druk of op een lange druk van
de ingang in. Een druk is als lang beschouwd wanneer hij 0,4 seconden overschrijdt. 

Om de lange druk-optie te kiezen, kies de « 2 functies » in de instellingen van de Ingangs-
module.

Kies de « 2 functies » enkel als twee verschillende acties aangesloten zijn aan de Ingang.
Bv. : een uitstel op de korte druk en een afwisselend ON/OFF-actie op de lange druk. 

De dimmer-functie en de rolluik functie acties schakkelen de 2 functies-optie automatisch
uit.

 Pas op, de lange druk niet valideren zonder de programmatie van de link op deze
knop die de twee druktypes gebruikt. Zonder programmatie riskeert de gebruiker de tijd
van de korte druk te overschrijden en in de lange periode aan te komen. En dus geen actie
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hebben.  

Procedure : 

1. Kies de tab Ingang (1) 

2. Klik op de knop module instelling (2)  

3. Kruis het hokje « 2 functies » aan die overeenkomt met de ingang die verenigd is
aan de link. 

4. OK.

De optie  'Actie  op  einde  drukken' geeft  de  mogelijkheid  om de  link  enkel  tijdens  het
loslaten van de ingang te realiseren. 

De instelling van elke module is in het vervolg van deze handleiding besproken.

Omkering van het ingangsignaal     :

De omkeer-functie geeft de mogelijkheid om het signaal dat doorgegeven wordt door een
sensor om te draaien. Deze functie is gebruikt wanneer het contact van de sensor normaal
gezien  een  gesloten  contact  (NC)  is  of  dat  de  verbruiker  die  aangesloten  is  aan  de
uitgang normaal gezien gesloten (NC) is.

Deze functie is toegangkelijk via het instellingscherm van de ingangmodules van button-
type of DISM0x.  
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Basisacties     : relais-type   uitgang  modules op drukknop-type   ingang

Relais-acties     :

De acties van een ingang-module, van het type drukknop, slepen-loslaten op een relais-
type uitgang stellen zich zoals hieronder getoond voor. De hierna beschreven acties zijn 
op de volgende modules van toepassing : 

. DBIR01 ; DTRP01 ; DLED01 ; Auxiliaire uitgangen DMV01 ; DMR01.

. De ingangen-modules van drukknop-type DPBU0x.

Afwisselend AAN/UIT     :

Een eerste druk op de ingang kan de inschakkeling van de uitgang zijn. Een tweede druk
veroorzaakt de uitschakkeling van deze uitgang. 

AAN :

Een druk op de ingang veroorzaakt de inschakkeling van de uitgang. 

UIT :

Een druk op de ingang veroorzaakt de uitschakkeling van de uitgang.

Vasthouden :

De uitgang is enkel ingeschakkelt wanneer de ingang geactiveed en behouden wordt. 

Timer functie :

Een druk op de ingang veroorzaakt het begin van de actie op de uitgang. Het kan owfel
de inschakkeling owfel de uitschakkeling zijn. Deze actie zal de ingestelde timer functie-
periode duren. De maximale tijdsduur van een timer functie is 720 minuten.

De selectie van de timer-actie laat de volgende instellingen verschijnen. Ze programmeren
de tijdsduur van de timer fucntie-actie op de uitgang. 
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1. De optie Begin > AAN schakkelt de uitgang tijdens een bepaalde tijd in. 

2. De optie  Begin > UIT schakkelt de  uitgang tijdens een bepaalde tijd uit en dan
schakkelt het terug in. 

3. De optie Bepaalde tijdsduur bepaalt de tijd van de timer functie. 

4. De optie  Actie op herdruk geeft drie actietypes mogelijk tijdens een nieuwe druk
gedurende de timer functie  periode. De  actie op herdruk is een actie op dezelfde
schakelaar.

• Kan een heroplading van de timerperiode zijn.  

• Kan een uitvoering van de eindactie zijn.  

• Kan  ook geen actie zijn. 

Als een actie ingeschakkelt wordt door een ander ingang van het systeem (schakkelaar,
uurwerk,  enz.)  op  een  zelfde  getimede uitgang,  zal  de  timer  die  aan  de  gang  is
geannuleerd worden. 

Uitstel   :

Men kan hiermede de uitvoering van de link uitstellen.  

De selectie van de Uitstel-tab geeft de mogelijkheden aan van devertraging van de actie
op de uitgang .. 

De  optie  Actie  op  herdruk geeft  vier  actietypes  mogelijk  tijdens  een  nieuwe  druk
gedurende de uitstelperiode. 
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1. Het kan  een herlading van de uitstelperiode zijn.

2. Het kan een onderbreken van de uitstelperiode  zijn. Hij delete zo het uitstel en de
uitvoering van de link. De uitgang zal dan niet geactiveerd worden. 

3. Het kan een uitvoering van de eindactie zijn. De uitstel is geannuleerd en de actie
wordt onmiddelijk uitgevoerd. 

4. Het kan  geen actie zijn. De uitstel loopt in ieder geval tot de ingestelde periode .
 

 Uitstel is vaak gebruikt tijdens het uitschakkelen van het hele huis. Het geeft de
gebruiker de mogelijkheid om niet  direct  in het  donker te zijn.  Hij  heeft  bijvoorbeeld 1
minuuut om  het huis te verlaten. En  de deur te sluiten en bv in zijn auto te stappen..

 Wanneer je je cursor van je muis boven één van de vermelde acties laat, verschijnt
de beschrijving van de actie.

Basisaccties     : modules van   uitgang     Dimmer  -type   op   ingang   drukknop-type

De acties van een  inganglink van drukknop-type op een uitgang van het type  dimmer
stellen zich als het volgende voor. De hierna beschreven acties zijn van toepassing op de
volgende modules : 

. DDIM01 ; DOUT10V02 ; DDMX01 ; DINTDALI01
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De acties van het type AAN/UIT afwisselend, AAN, UIT en Vasthouden zijn in het punt
Basisacties : relais-type uitgangmodules op drukknop-type ingang (p73) besproken. 

Dimmer-acties     :

Dimmerwaarde :

Geeft de mogelijkheid om een lichtbron, op een bepaald percentage van zijn maximale
waarde,  in  te  schakkelen.  Om de  uitgang uit  te  schakkelen,  moet   een  tweede  link
aangemaakt worden of de afwisselende Waarde/UIT-actie gekozen worden.  

De stijgtijd is de periode waarin de lichtbron de ingestelde waarde zal bereiken.

Dimmerfunctie :

Deze actie geeft de mogelijkheid om de waarde van een lichtbron te variëren naargelang
de tijdsduur van de druk op de ingang.   

Een korte actie op de  ingang,  wanneer de lichtbron uit  is,  steekt  de lichtbron op zijn
maximale waarde aan. Een korte actie op de ingang wanneer de lichtbron aan is, dooft de
lichtbron.  

Een lange actie op de ingang wijzigt de intensiteit.. 

Timer functie   :

Deze  functie  maakt  de  inschakkeling  van  een  lichtbron  tijdens  een  bepaald  periode
mogelijk. Zowel de stijgtijd als de toegepaste waarde zijn configureerbaar via de dimmer-
tab.  Basisinformatie  over  de  timer  functie is  in  het  hoodstuk Basisacties :  relais-type
uitgangmodules op drukknop-type ingang (p73) terug te vinden. 

Afwisselende Waarde/UIT:

De actie schakkelt een lichtbron aan een bepaald percentage van haar maximale waarde
in.

Een actie op de ingang wanneer de lichtbron uitgeschakkelt is veroorzaakt het aansteken
van deze aan de bepaalde waarde.

Een actie op de ingang wanneer de lichtbron aan is veroorzaakt zijn uitschakkeling.

De  stijgtijd  is  van  toepassing  tijdens  het  aansteken  en  tijdens  het  uitsteken  van  de
lichtbron. 

Basisacties :  Uitgang-modules  van  motor-type  met  twee  richtingen  op  ingang van
drukknop-type. 

De acties van een inganglink van drukknop-type op een uitgang van motor-type met twee
richtingen stellen zich als hier onder voor. De hierna beschreven acties zijn van toepassing
op de volgende modules : 

. DTRV01 ; DTRP02 ; DTRVBT01
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Motor-acties met twee richtingen     : 

Stijgen   :

De actie maakt het automatisch stijgen van een luik mogelijk. De instellingen op het
scherm hieronder wijzen naar de stijgtijd van het luik. 

Dalen: 

De actie maakt het automatisch dalen van een luik mogelijk. Zoals voor de actie 
«Stijgen» is het mogelijk om de daaltijd van het luik in te voeren. 

Stijgen met vasthouden     : 

De actie maakt het manuele stijgen van een luik door een lange druk en een korte
druk te combineren mogelijk. De  korte druk laat een stijging met  eindkoers timer functie
toe. De lange druk laat een stijging met vasthouden toe.

Dalen met vasthouden     :

De actie maakt het manuele dalen van een luik door een lange druk en een korte
druk te combineren mogelijk. De korte druk laat een daling met eindkoers timer functie toe.
De lange druk laat een daling met vasthouden toe.

Rolluikfunctie     :

De rolluik functie bestuurt de stijging en de daling via één enkele drukknop. De
korte en lange drukken zijn automatisch geselectionneerd. 

Een korte druk op de bedieningsknop activeert de stijging of de daling van het luik. Een
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nieuwe druk tijdens de stijging of de daling stopt de beweging. Als er geen enkel druk
uitgevoerd is tijdens de beweging, zal het luik op het einde van de ingestelde tijdsduur van
de stijging/daling stoppen. 

Een vastgehouden druk op de bedieningsknop veroorzaakt de manuele stijging of daling
van het luik. De beweging stopt na het loslaten van de knop. 

 De stijging- en dalingbedieningen zijn afwisselend. Een stijgingbediening moet door
een dalingbediening gevolgt worden. Twee opeenvolgende stijging- of dalingbedieningen
zijn dus onmogelijk op deze functie. 

UIT   :

De  actie  laat  de  onmiddelijke  stilstand  van  een  luik  toe,  om  het  even  welke
beweging bezig is. 

Boven puls     :

Tijdens de automatisering van lamellenluiks  (Amerikaanse luiken), is het mogelijk
om de oriëntatie van de lamellen te controleren door het inschakelen van opeenvolgende
pulsen van het relais. De actie laat de zending van een aantal stijgende pulsen tijdens een
hogetijdperiode toe. Het aantal pulsen is gescheiden door een rusttijd.   

Beneden puls     : 

Tijdens de automatisering van de Amerikaanse luik, is het mogelijk om de oriëntatie
van de lamellen te contreleren door het inschakelen van opeenvolgende pulsen van het
relais.  De  actie  laat  de  zending  van  een  aantal  dalende  pulsen gedurende  een
hogetijdsperiode toe. Het aantal pulsen is gescheiden door een rusttijdperiode. 

 De actie laat het manuele stijgen van een lamellenluik toe door een lange en een
korte druk te combineren. De korte druk laat een stijging met eindkoers timer functie toe.
De lange druk laat het inschakelen door pulsen met vasthouden toe.  

Amerikaanse blind functie beneden     :
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Tijdens de automatisering van het lamellenluik is het mogelijk om de oriëntatie van
de  lamellen  te  controleren  door  het  inschakkelen  van  opeenvolgende  pulsen  van  het
relais. De actie laat de manuele daling van een lamelleblind toe door een lange druk en
een korte druk te combineren. De korte druk laat een daling met eindcourse timer functie
toe. De lange druk laat de inschakkeling door pulsen met vasthouden toe.  

Amerikaanse luik functie     : 

De functie  Amerikaanse luik  laat  toe om zowel  de stijging en de daling als  het
draaien door pulsen via één enkele drukknop te beheren. De lange en korte drukken zijn
automatisch geselectionneerd. 

Een korte druk op de ingang activeert de stijging of de daling van het luik. Een nieuwe 
druk tijdens het stijgen of het dalen stopt de beweging. Als er geen enkel druk uitgevoerd 
wordt tijdens de beweging, zal het luik op het einde van de ingestelde tijdsduur van het 
stijgen/dalen stoppen.

De lange druk laat het inschakelen van pulsen met vasthouden, naar boven of naar 
beneden, naargelang de laatste beweging van de uitgang, toe. 

 De stijging- en dalingbedieningen zijn afwisselend. Een stijgingbediening moet door
een dalingbediening gevolgd worden. Twee opeenvolgende stijging- of dalinbedieningen
zijn dus onmogelijk op deze functie.  

Linken op analoge ingangen-module 0-10V     : DINT10V02

De linken die in dit gedeelte voorgesteld zijn, zijn toegangkelijk als de DIN10V02-module
op de analoog ingangmode staat. In het geval van de activatie van de temperatuuringang,
het hoodstuk Temperatuursbeheer(p124) raadplegen. 

Beheer van een actie volgens het spannigsniveau 0-10V

Het aanmaken van een link op de DIN10V02-module voert  zich volgens een analoge
waarde uit. 

1. Actie als de analoge waarde Boven een spannigsniveau 0-10V is. 
2. Actie als de analoge waarde Onder een spanningsniveau 0-10V is.
3. Actie als de analoge waarde Gelijk aan een spanningsniveau 0-10V is. 
4. Actie als de analoge waarde Begrepen is tussen een spanningsniveau 0-10V.

. Voor een dimbare uitgang kan de actie uitgevoerd worden volgens een wiskundige
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functie. Kies Functie, klik rechts op het diagram en Wijzig.  

Maak een functie  aan  door  in  het  diagram te klikken.  De INPUT-waarde (analogisch
signaal) staat op de x-as. De OUPUT-waarde staat op de y-as. De functie kan doorlopend
of in stappen gebeuren. Bevestig de opname van de functie door op OK te klikken. 

Tijdens het aanmaken van een bestaande functie is het mogelijk om een nieuwe functie te
wijzigen of toe te voegen. 

 Bijvoorbeeld : Gebruik een lichtsensor die een analogisch signaal 0-10V aangesloten
op de DIN10V02-module  uitzendt.  Volgens het  niveau van de lichtintensiteit  zullen  de
dimmer-interfaces van de kamer zich aanpassen om een constante licht uit te zenden.   

DRS23201, DUSB01, DRS23202, DETH02     , DRS23203 en DGSM01-linken
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Beheer van de berichten voor de DRS23201 / DUSB01-modules

Het  aanmaken  van  een  link  met  een  DRS23201/DUSB01-module  laat  het  volgende
scherm verschijnen : 

Om een link aan te maken, bepaal de berichten die uitgewisseld moeten worden door op
de knop Tekstbeheer te klikken. 

 Het beheer van de teksten kan ook via het menu Project > Tekstbeheer uitgevoerd
worden. 

Om een nieuw bericht toe te voegen, schrijf het in het invoerveld. Klik op Toevoegen om
het in de lijst toe te voegen. Pas op, de grootte van de teksten moet niet de 32 tekens
overschreiden.  

Om een bericht te wijzigen, kies het in de lijst (hij is dan in het blauw onderlijnd). Wijzig het
bericht in de onderstaande lijn. Om de wijziging te bevstigen, klik op wijzigen. Het bericht
is nu gewijzigd. 

Om het bericht te verwijderen, kies het in de lijst (hij is dan in het blauw onderlijnd). Klik op
verwijderen. Het bericht is nu van het lijst verwijderd.  

Als de « uitgebreide mode » geactiveerd is, moeten de codes ASCII die tussen 0 en 31
begrepen zijn  in  decimaal  (altijd  twee tekens)  en  omcirkeld  door  de  '<'  en  '>'  tekens
genoteerd zijn.

 Bijvoorbeeld : Om STX en GS te sturen, moet je '<02><19>' schrijven (zonder de 
aanhalingstekens). 

Bericht sturen (enkel met DRS23201 en DUSB01)

Deze actie bekomt men wanneer de uitgang van de DRS23201/DUSB01-module (rechts 
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van het scherm) aangesloten is aan een ingang. Het instellingscherm is het volgende : 

Kies het bericht dat behandeld moet worden en valideer het door op OK te drukken. 

Activatie van een uitgang na het ontvangen van een bericht.

Deze  actie  is  bekomen  wanneer  een  uitgang aan  de  ingang van  de
DRS23201/DRS23202  /DETH02/DUSB01-module  aangesloten  is  (in  het  hoofdgedeelte
van het scherm).

Kies het bericht dat behandeld moet worden en configureer de link op de manier die in het
hoodstuk  uitgelegd  wordt :  Basisacties :  relais-type  uitgangmodules  op  drukknop-type
ingang (p73)

Bevestig door op OK te drukken. 

Berichtbeheer voor de   DETH02-module

Behalve  zijn  configuratiescherm  heeft  de  DETH02-module  dezelfde  functies  als  de
DRS23202-module.  

Buiten het gebruik van het Domintell Light Protocol, is het mogelijk om  inganglinken te
scheppen op de DETH02-module. Deze functie controleert het Domintellsysteem dankzij
het versturen van andere berichten dan die gebruikt worden door het Light Protocol. 

Berichtbeheer voor de DRS23203-modules (Module B&O, Bang & Olufsen)

De DRS23203-interface, of B&O1-interface, laat toe om de configuratie van een Bang &
Olufsen-toestel  aangesloten  aan  een  Master  Link  Ikatu-interface  die  van  een  RS232-
seriepoort  beschikken  te  controleren.  De  DES23203-module  zendt  enkel
besturingsopdrachten naar de Master Link Ikatu-interface uit. 

 

1 B&O en Bang and Olufsen zijn gedeponeerde merken. http://www.bang-olufsen.com
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De DRS23203 beschikt over een automatisch generatiebibliotheek van de besturingcodes.
En dit in functie van de  Master Link Node-adressen van de verschillende B&O-modules
van de installatie. 

Procedure : 

1. Maak de link door het slepen-loslaten van het RS23203-interface op de gewenste
ingang. 

2. In het venster linkcreatie, kies het type van toestel. 

3. Bepaal of het over de audio- of videogedeelte van het toestel gaat. 

4. Voer de waarde van zijn Master Link Node-nummer in de B&O-installatie in. Deze
informatie moet in de Master Link Ikatu-interface geprogrammeerd worden door de
persoon die verantwoordelijk is van de B&O-installatie. 

 Bijvoorbeeld : Om het geluid van een televisie die de Master Link Node « 3 » heeft
zacher te zetten, moeten er twee codes verstuurd worden. Één om zich aan de televisie te
connecteren en de andere om het geluid zachter te zetten. Volgens de grootte van de
installatie kan een uitstel tussen twee codes nodig zijn. Hieronder vind u de visualisatie
van de link.

Berichtbeheer voor de DGSM01-module

De DGSM01-interface beschikt van dezelfde functies als de DRS23201 en DUSB01-
modules. In het geval van de DGSM01,  is het versturen van een SMS de reactie van 
een gebeurde actie of het sturen van  een SMS bericht naar de GSM module die een 
actie gaat uitvoeren in het systeem. 

 Bijvoorbeeld :  De  DGSM01-module  stuurt  een  SMS  om  een  inbraak  te
waarschuwen. Het is mogelijk om een SMS naar de DGSM01 te sturen om alle lampen
van de installatie aan te steken en zo de dief doen vluchten.
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Het beheer van de telefoonnummers is in het  telefoon repertorium opgesteld (Project >
telefoon repertorium). 

Het  telefoon  repertorium bevat  de  nummers  van  de  personen  die  een  SMS  aan  de
DGSM01 kunnen ontvangen en sturen. Zodat een SMS die verstuurd is van een bepaald
telefoon een actie kan inschakelen, moet de nummer bevat zijn in het telefoon repertorium
en de eigenschap « bericht aanvaarden »  beschikken.

. DGSM01-link als uitgang  (SMS zender)

1. Voer een slepen-loslaten van de uitgang DGSM01  op een ingangmodule 
(bv. : drukknop) uit. 

2. Voer de gewenste tekst in.

3. Bevestig door op OK te drukken. 

 Bijvoorbeeld : de sensor van het waterniveau van uw kelder zet zich aan, de 
DGSM01 stuurt een SMS « OVERSTROMING ».  

. DGMS01-link als ingang (SMS ontvanger) 

1. Voer een slepen-loslaten van een uitgangelement (bv. : keukenlamp) op het 
ingangelement van de DGSM01  uit.

2. Kies de tekst die de actie uitvoert. 

3. Kies de actie die uitgevoerd moet worden.  

4. Bevestig door op OK te drukken. 

 Bijvoorbeeld :  Ik  verlaat  snel  het  huis.  Na 15 minuten besef  ik  dat  ik  sommige
lampen niet uitgezet heb. Ik stuur een SMS 'alle lampen UIT' om een algemene uitdoving
uit te voeren. 

DMV01-link
De module  beschikt  van  3  uitgangen van  ventilatiebeheer  en  2  hulpuitgangen.  Het
beheer van de linken van de hulpuitgangen voeren zich als de relais van een DMR01-
module  uit.  Voor  hun  configuratie,  ga  naar  het  hoofdstuk :  Basisacties :  relais-type
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uitgangmodules op drukknop-type ingang (p 73)

Ventilatielink op een ingang van drukknop- of uurwerktype

De acties van het ventilatiebeheer zijn : 

.  Het  inschakkelen  van  een  bepaalde  snelheid.  UIT,  Snelheid  1,  Snelheid  2,
Snelheid 3. 

. Het verhogen van de snelheden met mogelijke waardenkring.

. Het verminderen van de snelheden met mogelijke waardenkring.

. Het stoppen van de module. De 3 relais zijn onderbroken.

Ventilatielink op analogisch ingang 0-10V (DIN10V02)

Volgens de analogische waarde is het mogelijk om de ventilatiesnelheden in te schakelen.
Om het beheer van de analogische waarden van de DIN10V02 te configureren, raadpleeg
de title : Linken op analoge ingangen-module 0-10V : DINT10V02 p(79)

De acties van de ventilatiebeheersing in een link met een DIN10V02 zijn : 

. Het inschakkelen van een precies snelheid. UIT, Snelheid 1, Snelheid 2, Snelheid
3

. Het stoppen van de module. De 3 relais zijn losgelaten.

DAMPLI01-link

De DAMPLI01-module is een audioversterker die de geluidsdistributie van 4 audiobronnen
aan  4  audiozones  toelaat.  De  uitgezende  bronnen  komen  van  onafhankelijke
hulptoestellen (bv. : CD speler, DVD speler, bandopnemer, BlueRay,  audio server, ...) of
van één van de vier FM-tuners die geïntegreerd zijn in de module zelf.  De versterker is
uitgerust  met  4  stereo  luidsprekeruitgangen  en  4  audio  out  uitgangen  waaop
hulpversterkers  kunnen worden aangesloten.. 

Om de basisinstellingen van de DAMPLI01 te configureren, lees het hoodstuk : Selecteren
van de radiostations : (p60)

 Voor een visualistie van de audiobesturingen van de DAMPLI01 is het aangeraden
een touchscreen te gebruiken. Buiten het schermassortiment dat Domintell voorstelt, is het
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mogelijk  om  de  audiobeheer  via  applicaties  voor  smartphones,  Androîd,  IOS,...  te
besturen. .

Aanmaken van linken op de   uitgangen   van de DAMPLI01-module

Het gebruik van de DAMPLI01-module vereist het aanmaken van linken tussen ingangen
van de configuratie en de uitgangen van de DAMPLI01-module. 

Omdat de acties opeenvolgend zijn, kies ze één per één tussen de 3 belangrijkste types.
(Geluid, Tuner  en Bron). Om de inschakkeling van een radiozender aan een geluid van
50% uit te voeren, moeten er 2 linken zoals hieronder aangemaakt worden. 

Herinnering : elk paar luidsprekers die aan de module aangeschakeld is, wordt als één
enkele uitgang beschouwd. 

1. Link van een audiouitgang op een drukknop

Geluidbeheer : 

• Uit : Deze actie sluit de uitgang. 

• Geluid harder zetten : Deze actie zet het geluid van de uitgang via elke puls op de
ingang 2 db hoger. Een lange druk op de ingang schept de dynamische toeneming
van het geluid.  

• Geluid zachter zetten : Deze actie zet het geluid van de uitgang via elke puls op de
ingang 2  db  zachter.  Een  lange  druk  op  de  ingang  schept  de  dynamische
vermindering van het geluid. 

• Geluid : Deze actie  laat  toe  het  percentage van  het  geluid  in  te  stellen  via  de
keuzelijst Geluid. Het is ook mogelijk om een overgangstijd in te stellen.

• Geluid AAN/UIT :  Deze actie activeert en sluit de uitgang in één enkele link. Een
eerste druk op de  ingang van de link laat toe de percentage van het geluid te
krijgen via de keuzelijst Geluid. Een tweede druk laat toe de uitgang te sluiten.  

• Geluidsfunctie : Deze functie laat toe het geluid zachter of harder te zetten via één
enkele ingang. De toenemings- en verminderingsbesturingen zijn afgewisseld : een
toename  moet door een afname van het geluid  gevolgd worden en omgekeerd. De
korte drukken laten het sluiten of het inschakkelen van de uitgangen toe. De lange
drukken geven de mogelijkheid om het geluid dat toegepast is aan de uitgang te
wijzigen. 

Voor de geluidfuncties, Geluid harder zetten en Geluid zachter zetten, zijn de lange
en korte  drukken automatisch  geselectionneerd.  Het  is  mogelijk  om de uitgang
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sequentieel of dynamisch te besturen.  

Het is mogelijk om een overgangstijd te bepalen voor de UIT-, Geluid-, Geluid AAN/UIT-
acties. Het gaat over de periode die door de  uitgang genomen is om het vastgestelde
volume  te  bereiken.  Deze  instelling  wordt  via  de  keuzelijsten  van  de  overgangstijden
bepaald.  

Beheer van de radiozenders : 

• Up scan  : laat de toenemende scan van de radiozenders toe.

• Down scan : laat de afnemende scan van de radiozenders toe. 

• Frequentie :  geeft  de  mogelijkheid  om  de  radiozender,  waarvan  de  frequentie
gekend is, direct te bereiken via het veld Frequentie. 

• Zender : laat toe om een bewaarde radiozender in de databank te bereiken. De
keuze van de zender voert zich via de keuzelijst Zender uit. 

• Volgende zender of vorige zender :  laten toe om de zenders die bevat zijn in de
groep van de zenders die aan de uitgang toegekend is door te lopen.  

Beheer van de bronnen : 

• Keuze van de bron : Laat toe om één van de bronnen die geconnecteerd zijn aan
de DAMPLI01-module te kiezen. De keuze van de bron voert zich via de keuzelijst
Bron.

• Vorige  bron  of  volgende  bron :  Laten toe  om de verschillende hulpbronnen  die
geconnecteeerd zijn aan de DAMPLI01-module (bv. : BlueRay, PC, TV,...) door te
lopen. 

2. Link van een audiouitgang op een uurwerk.

Actie :

• UIt : deze actie sluit de uitgang.
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• Geluid :  deze actie laat toe om de percentage van het bepaalde volume via de
keuzzelijst Geluid te krijgen. Het is mogelijk om een overgangstijd te configureren. 

• Frequentie :  geeft  de  mogelijkheid  om een  radiozender  waarvan  de  frequentie
gekend is, direct te bereiken via het veld Frequentie.  

• Zender :  laat toe om een bewaard radiozender in de databank te bereiken. De
keuze van de zender voert zich via de keuzelijst Zender uit.  

• Keuze van de bron : laat toe om één van de bronnen die geconnecteerd zijn aan de
DAMPLI01-module  direct  te  kiezen.  De  keuze  van  de  bron  voert  zich  via  de
keuzelijst Bron uit.  

DIREMIT01-link

Codes leren kennen

Om de beheersing van de codes te bereiken, klik rechts op de uitgang van d IR-uitzender,
en kies Bewerken. Kies dan beheer IR code. 

Meer informatie over de instellingen van de DIREMIT01 in het hoodstuk : Beheer IR Code:
(p63)

Creatie van linken

Procedure : 

1. Om een link te maken, sleep en laat los de uitzender die gebruikt moet worden op
de gewenste ingang.

2. Een parameterscherm verschijnt : kies, één van de bewaarde acties die uitgevoerd
moet worden voor deze link, in het gedeelte IR code.  

3. In het rechste gedeelte, kies de  zend IR code, of  IR code onderhoud (bv. : wordt
gebruikt om de toeneming van het geluid van een HIFI-installatie te controleren).

4. Onder de IR code gedeelte is het mogelijk om een Pauze tussen elke code in ms
(milliseconden)  in  te  voeren.  Het  wordt  gebruikt  wanneer  een  actie  een
uitvoeringstijd nodig heeft, en dat de volgende actie niet onmiddelijk realiseerbaar
zou zijn. (Bv. : het starten van een DVD-player gevolgd door de Play). 

5. Klik op OK om de link te finaliseren. 
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 Sommige toestellen vragen een lange pauze tussen 2 acties.  Bijvoorbeeld,  tijdens het
opstarten van de toestel.  In dit  geval is het aangeraden om twee opeenvolgende linken op de
ingang uit te voeren en om een Uitstel in seconden toe te passen.

DTSC02; DTSC04-linken

Dit gedeelte hervat de functies van de scherm- en DTSC04 videovergrendeling. De linken
betreffende  de  led  verlichtingen  zijn  bevat  in  het  hoodstuk  Basisacties :  relais-type
uitgangmodules op drukknop-type ingang(p73). 

Programmeren van de Acties knoppen

Elk scherm beschikt van 4 programmeerbare Actieknoppen.

Deze knoppen zijn tactiele drukknoppen op basis waarvan het mogelijk is om linken te
programmeren. De instellingen en de naam van deze knoppen zijn bewerkbaar. Ze zijn
zichtbaar wanneer een link geschapen wordt. 

Selectie van de pictogrammen

Mogelijkheid om de standaard toegewezen pictogrammen te bewerken. De pictogrammen
zijn in een lijst hervat. Via het menu Project > Pictogrammen kiezen. 
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Procedure : 
1. Kies het elementtype (ingang, uitgang, sensoren, verdiepingen/kamers, sferen,

memos,...)  waarvoor  de  pictogram  bewerkt  moet  worden.  Loop  de  keuzelijst
rechtsbonvenop door (1).

2. Kies het element waarvoor de pictogram vervangen moet worden. Loop de rechtse
kolom door (2). De standaard pictogrammen verschijnen linksbovenaan (3). 

3. Kies de pictogram die het element in zijn AAN-status voorstelt in de lijst (4). Sleep
en laat los het in het vierkant  Beeld AAN. Voer dezelfde manipulatie uit voor de
andere staten. 

Afscherming van sommige elementen op het touchscreen

Het kan voorkomen dat sommige elementen van de installatie niet getoond  moet worden. 

Procedure : 
1. Kies het element dat niet getoond moet worden
2. Klik op het groene v « » om het element van de schermen te verbergen. Een rood

kruis « » links van deze elementen toont dat ze niet op de scherm verschijnen. De
Led terugkoppeling, de ingangen en de variabels zijn standaard verborgen.   

 Interssante functie wanneer uitgangen van de installatie ongebruikt zijn of wanneer
variebels of memos niet beheerst moeten worden. 

Instelling van de schermen

Standaard, volgt de weergave van de elementen op de DTSC0x-schermen de configuratie
van de boomstructuur die vastgesteld is in de eerste kolom van de Domintell2 software. Er
is  de  mogelijkheid  om  een  verschillende  weergave  voor  elk  scherm  van  het  huis  te
hebben. Mogelijkheid om de orde van de elementen te bepalen, om sommige elementen
te  verbergen  of  aan  te  tonen.  Het  instellen  wordt  essentiëel  wanneer  de  installatie
meerdere touchscreens bevat en dat het noodzakelijk  is om de besturings volgens de
plaats  van  elk  scherm  te  verdelen.   De  bepaalde  instellingen  zullen  enkel  voor  de
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betrokkenen DTSC0x-module van deze applicatie  zijn.  Alle  veranderingen gerealiseerd
voor  een  lokaal  scherm  zullen  niet  op  alle  andere  schermen  van  de  installatie
weergegeven worden. 

 Bijvoorbeeld :  een  industrieel  gebouw  beschikt  van  2  DTSC0x-schermen.  Het
scherm dat geïnstalleerd is in het kantoor van de directeur kan de hele installatie besturen.
Het  ander DTSC0x-scherm bestuurt enkel de plaatsen die vooraan in het gebouw staan. 

Om de instellingen van het scherm te bereiken : klik rechts op één van de actieknoppen
van het scherm dat geconfigureerd moet worden > kies de optie Scherm parameter. 

Het linkse gedeelte van het instellingenvenster bevat :

• Het  component menu :  het  bevat  alle  elementen  die  op  het  hoofdscherm
weergegeven zijn. 

• Het  temperatuur menu : het bevat alle  temperaturensensoren,  temperatuurmodes
en  temperatuurprofils die  weergegeven  zijn  in  het  submenu  Beheer  van  de
climatisatie van het scherm.  

• Het uurwerk menu : het bevat alle aangemaakte uurwerken die in submenu Beheer
van de uurwerken van het scherm zullen weergegeven kunnen worden. 

Het rechtse gedeelte van het instellingenscherm bevat de verschillende elementen die in
het overeenkomstig scherm of menu zullen weergegeven kunnen worden. 

Standaardinstellingen     :

Elk scherm is volgens een standaardweergave ingesteld :

• het huisinstelling verschijnt zoals ze is aangemaakt ;

• de uitgangen zijn per type en per toenemende orde van de serienummers van de
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modules weergegeven ;

• de ledterugkoppeling, de ingangen en de variabels worden niet weergegeven ;

• de  elementen  die  verborgen  zijn  via  het  venster  van  het  beheer  van  de
pictogrammen worden niet weergegeven. 

Personaliseer  de  boomstructuur  van  een  lokaal  scherm  door  de  optie
Standaardinstellingen gebruiken uit te vinken.  

Instellingen mogelijkheden     :

• Bepaling van de volgorde van de elementen :
Organiseer  het  hoofdscherm door  vertikale  slepen-loslaten behandelingen uit  te
voeren in het linkse gedeelte van het venster. 

• Verwijderen van elementen :
Klik  rechts  en  verwijder de  elementen  die  niet  op  het  hoofdscherm moeten
verschijnen.  De  elementen  keren  terug  naar  het  rechtse  gedeelte  van  het
instellingenscherm. 

• Toevoeging van elementen :
Door  slepen-loslaten behandelingen  via  het  rechtse  gedeelte  van  het
instellingenvenster, voeg elementen toe die niet in het hoofdscherm zijn. 

• Bewerking van de namen en pictogrammen die aan de  kamers et  verdiepingen
toegekend zijn : 
Klik rechts op het element dat bewerkt moet worden en vervang de namen en/of de
pictogrammen die bepaald zijn voor de kamers en de verdiepingen. 
De pictogrammen van de de andere types van elementen (ingangen, uitgangen,
memos,... ) zijn gemeenschappelijk aan alle schemen en zijn niet bewerkbaar via
het instellingenvenster van de touchscreens. Om ze te bewerken, zie hoofdstuk :
Selectie van de pictogrammen (p89)

Afscherming van de menu's

Sommige menu's en instellingen van de touchscreens kunnen berschermd zijn. Via het 
instellingenvenster van een scherm, kies de tab Beheer menu. 
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De afscherming van één van de menu's zal de toegang aan alle instellingen die hij bevat 
verwijderen. 

Desactiveer de menu's en de instellingen die moeten afgeschermd worden door ze te 
deselecionneren vanaf dit scherm. De menu's of afgeschermde instellingen zijn door een 
rood kruis « »weergegeven.

 Als het touchscreen een verandering van zijn OS moet ondergaan, zie hoofdstuk :
Voorbereidende handelingen aan de programmatie  (p7)

Screenlok link

Het grendeling van het scherm laat toe om de toegang naar de functies die aanwezig zijn
op het scherm tijdens de grendelperiode te blokeren. De grendelacties zijn dezelfde als
een relais-type module. Voor meer informatie : Basisacties : relais-type uitgangmodules op
drukknop-type ingang  (p73)

Stelt de grendelcode via het venster van de touchscreen in het gedeelte Grendel van het
scherm in. 

Tijdens de druk op het scherm, als de grendeling actief is, verschijnt er een keypad. Voer
de code in om het scherm te ontgrendelen. 

In het geval van de keuze van de code 0000, verschijnt er geen enkel keypad. In dit geval,
moet de ontgrendeling door een andere ingangelement van het systeem gebeuren.

 Bijvoorbeeld : tijdens het inschakkelen van het alarmsysteem, waarschuwt deze de
domotica en blokeert de touchscreen. Het alarmsysteem moet ontwapend zijn zodat het
scherm opnieuw beschikbaar kan zijn.
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Video DTSC04-link

Het DTSC04-scherm laat de weergave van de videostream toe dat van de DVIP01-
videofoon en IP camera's die geïnstalleerd zijn op het netwerk afkomt. 

Videolink

Door slepen-loslaten behandelingen, laat het venster link creëren verschijnen. 

. Camera starten

. Camera stoppen

Mogelijkheid van automatisch ontkoppeling na een bepaald periode. 

IP camera's management
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Het menu Project > IP camera's management neemt de lijst van de aanwezige 
camera's in de applicatie over. 

Verhoging van IP camera's ander dan de DVIP01-module

. Voor AXIS2 IP camera's : Klik op de knop IP camera's scan

.  Voor  andere  camera's  die  van  een  contact  URL  beschikken :  de
connectiesinstellingen, het IP-adres en het URL manueel invoeren. 

Om  de  URL  van  de  camera  die  ingevoerd  moet  worden  te  kennen,  lees  de
specificaties van de fabrikant van de camera of raadpleeg de website ISPY connect 

http://www.ispyconnect.com/sources.aspx#info

 Bijvoorbeeld: voor de D-LINK DCS 2121 IP camera gaat het over deze URL vorm:
http://IPADDRESS/video/mjpg.cgi . 

In de Domintell2 software moet u /video/mjpg.cgi inbrengen
De standaardcommunicatiepoort is 80, 
De login en het paswoord zijn die die gebruikt worden door de IP camera.

Aanmaken van meervoudige linken
Er bestaat de mogelijkheid om meerdere uitgangen te besturen vanaf één enkele ingang.
Zoals  voor  de  unieke  linken,  door  slepen-loslaten behandelingen,  programmeer  de
uitgangen  de  ene  achter  de  andere  naar  de  geselectionneerde  ingang.  Voor  elke
aangemaakte link verschijnt er een dialoogbox om de type van de link en zijn instellingen
te programmeren.  

2 Axis is een gedeponeerd merk. http://www.axis.com
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Als de acties van meerdere ingevoegde uitgangen gelijkwaardig zijn, lees : Groep (p100)
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Geavanceerde functie van de applicatie
Deze title bevat de procedure voor het scheppen van linken die niet opgenomen zijn aan 
de grote hoodstukken. : Basisacties : relais-type uitgangmodules op drukknop-type ingang 
(p73)
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Sferen
Het beheer van de sferen laat toe de configuratie van domotica-actoren in één actie te wijzigen.
Een sfeer bevat meerdere  uitgangen (lichtpunten, luikbesturingen, infra-rode codes, enz.). Het
toevoegen  van  een  sfeer  kent   standaardwaarden  aan  de  uitgangen toe.  Door  het  slepen-
loslaten wordt de sfeer aan een ingang verbonden. 

Het beheer van de sferen laat  toe een programmatie van meerdere linken tussen verschillende
uitgangen en één ingang te centraliseren. Dezelfde sfeer kan op meerdere ingangen gesleept
worden.

De  registratie functie  laat  toe  om  de  huidige  waarden  van  de  gegroepeerde  uitgangen  te
onthouden. Die waarden zijn toegepast  bij  de volgende druk op de  ingang bestemd voor de
uitvoering van de sfeer.  

Aanmaak van de lijst van de sfeeractoren

1. Kies  de  uitgangen die  tegelijkertijd  bestuurd  moeten  worden.  (relais,  dimmer,  luik,
variabels, SMS, enz.) 

2. Klik rechts op de pictogram Sfeer => Nieuwe groep toevoegen. 

 

3. Geef de nieuwe sfeer een naam. 

4. Door te slepen-loslaten van de rechterkolom naar de linkerkolom, maak een lijst met de
uitgangen die teruggenomen worden in de sfeer. 

5. Druk op OK om te bevestigen. 

Aanmaak van sferen. 

Bepaalt de waarden van elke uitgang die de sfeer vormt. Voor dezelfde sfeer is het mogelijk om
maximum 8 verschillende sferen aan te maken. 
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Gebruikswijze :

1. Klik rechts op de voordien insgestelde sfeer en kies de optie Sfeer toevoegen. 

De kolom Naam bevat de gekozen uitgangen. 

De kolom Actie bevat de soort actie toegepast op de uitgangen.   

De kolom  Parameters geeft de waarde aan die verbonden is met de soort actie. Deze
kolom wordt in het geval van een bediening via dimmer, audio, enz. aangevuld. 

2. Geef de sfeer een nieuwe naam

3. In de kolom Namen kies de gewenste uitgang. Kies het overeenstemmende vakje in de
kolom Actie. Kies een actie die verbonden is met de uitgang.  

4. Als de actie insgesteld kan worden, toont het deel  Parameters sfeer van het venster de
verschillende parameters die verbonden zijn met de gekozen type actie aan. 

5. Bevestig door op  Toepassen te drukken.  Die parameters worden nu aangetoond in de
kolom Parameters ter hoogte van de geconfigureerde uitgang. 

6. Voer de bewerkingen die beschreven zijn in punt 3 en 4 voor alle uitgangen van de groep. 

7. Beëindig de configuratie van de sfeer door op OK te drukken. 

 Bijvoorbeeod :  de  woonkamer  van  een  huis  is  uitgerust  met  de  kaarten  van  de  dimmer
(DDIM01),  luiken  (DTRV01),  audi  (DAMPLI01)  en  een  infrarood  zender  (DIREMI01).  Die  zijn
geselecteerd en vormen de sfeer SALON. Die sfeer wordt verdeeld in 4 verschillende sferen. 

• De sfeer Cosy : de dimmers staan op 70% en een zachte muziek weerklinkt. 

• De sfeer Filmprojectie : het scherm komt naar beneden, de projector wordt in gang gezet
en de dimmers worden uigedoofd op een tijdsspanne van 5 minuten. 

• De sfeer Eco: een lamp wordt tot 70% gedimd. De audio en de projector gaan over naar
een slaapmodus. 

• De sfeer OFF : alle actoren van de sfeer SALON worden uitgeschakeld. 

Uitvoering van de sferen

De uitvoering van een sfeer vereist de aanmaak van een link tussen een ingang en één van de
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voordien geschepte  sferen.  Door  te  slepen-loslaten plaats de gewenste  sfeer op een
domotica-ingang. Bij het aanmaken van de link, kies Uitvoering sfeer.  

Sferen opslaan

Een sfeer opslaan bestaat, op een pecries moment, in het opslaan van de waarden van de
uitgangen van sfeeractoren. Het opslaan scheptt een virtuele sfeer. Deze waarden worden
in het RAM geheugen van de DGQG01 opgeslagen. 

 De  uitvoering  en  het  opslaan  van  een  sfeer  kunnen  vanaf  één  enkel  ingang
uitgevoerd worden. Gebruik de functie Kort drukken voor de uitvoering en de functie Lang
drukken voor het opslaan.

 Bijvoorbeeld : beeld u in dat de waarden van de lampen van de woningkamer, wanneer
de sfeer  'video' geactiveerd is, de inwoners niet meer tevredenstellen. Het is dan mogelijk
om de waarden van die lampen aan te passen en ze dan op te slaan door op een ingang
(knop of andere) die aan dit functie bestemd is te drukken. De waarden zullen enkel voor
dit sfeer opgeslagen worden. De geprogrammeerd waarden voor de andere sferen blijven
dus onveranderd.

Groep
De groepen laten toe om meerdere  uitgangen (van dezelfde soort of van verschillende
soorten) in één zelfde uitgang te verzamelen. In één enkele link laat een groep toe om de
staat van meerdere uitgangen in één zelfde staat te veranderen. 

Verschillende soorten groepen : 

• De  Basisgroep :  verzamelt  de  volgende  uitgangen :  DLED01,  DMR01,  DBIR01,
DTRP01,  DDIM01,  DOUT10V02,  DAMPLI01,  DIREMI01,  terugkoppelingsled  van
schakelaars en variabels.

• De  Luikgroep :  verzamelt  de  besturingsuitgangen  van  motors  met  2  richtingen,
hoofdzakelijk de luiken. (DTRV01, DTRVBT01 en DTRP02).

• De Dimmergroep : verzamelt enkel de  dimbare uitgangen (DDIM01 et DOUT10V02).
Enkel deze groepsoort laat de acties  dimmer functie, dimmer waarde en afwisselend
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waarde/Off toe op de verzamelde dimmeruitgangen. 

• De Geluidgroep : verzamelt alle uitgangen van de DAMPLI01-modules. 

• De FAN-groep : verzamelt de uitgangen van de DFAN01-modules. 

• De DMX-groep : verzamelt de uitgangen van de DDMX01-modules. 

• De schermgroep : verzamelt de videouitgangen van de DTSC04-schermen. 

• De ledgroep : verzamelt de leduitgangen van de DPBR0x en DPBL0x-modules. 

• De DMVgroep : verzamelt de uitgangen van de DMV01-modules. 

• De DALI-groep : verzamelt de DALI-uitgangkanalen van de DINTDALI01-interfaces. 

Aanmaak van een groep

Procedure : 

1. Klik rechts op de pictogram Groepen van de uitgangkolom. 

2. Geef de nieuwe groep een naam. 

3. Door te slepen-loslaten van de rechter- naar de linkerkolom, maak de lijst van de
uitgangen die teruggenomen zijn in de groep. Om meerdere uitgangen in één keer

toe te voegen, kies de gewenste uitgangen en klik op de knop  . Mogelijkheid om

één of meerdere uitgangen van de groep te verwijderen door op de unieke pijl  

of op de algemene pijl   te drukken.

 Gebruik  een  groep wanneer  meerdere  uitgangen  van  dezelfde  soort  door
dezelfde  ingang bestuurd  moeten  worden.  Dit  laat  toe  om  een  uitgangsgroep
gemakkelijker  op  een  andere  ingang  terug  te  plaatsen.  De  groep  vermijdt  de
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desynchronisatie van de link, omdat de hele groep dezelfde staat aanneemt.   

Wijzigen van een groep

Mogelijkheid om de samenstelling van een groep te wijzigen om één of meerdere 
uitgangen toe te voegen of te verwijderen. Klik rechts op de groep > Bewerken.  

Voor de stabiliteit van de applicaite is het onmogelijk om een groep te verwijderen als 
hij gebruikt wordt in een link. Men moet eerst de link verwijderen om dan de groep te 
kunnen verwijderen. 

Aanmaak van een   groep  link

Vanuit  het  standpunt  van  programmatie  is  een  groep als  een  unieke  uitgang
beschouwd. De aanmaak van een groeplink is gelijk aan een link tussen een ingang en
een uitgang. 

De staat van de groep is de staat van het eerste element van de elementenlijst die de
groep vormt. 

De voorgestelde acties hangen van het groepsoort af. Voor meer informatie, raadpleeg
het hoodstuk Basisacties : relais-type uitgangmodules op drukknop-type ingang (p73)

 De  Basisgroep kan  enkel  de  basisacties  (afwisselend  ON/OFF,  ON,  OFF,
vasthouden, temportisatie) uitvoeren, zelfs als hij enkel uit dimmer-modules samengesteld
is. 

De volgers

Manuele volgers

De functie  volger laat toe om de staat van een uitgang op een ander  uitgang terug te
brengen zonder rekening te houden met de besturing uitgevoerd op de eerste. 

 De manuele volger wordt gebruikt wanneer een neon gecontroleerd is door een 0-10V
dimmer. In sommige gevalen, moet de voeding van de neon uitgeschakeld worden als de
dimmer aan 0% is. 

Procedure : 

1. Kies  de  volguitgang en  verplaats  het  naar  de  pictogram  volger in  de
ingangenkolom. 

2. In de dialoogbox, kies de gevolgde uitgang. 
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3. Bevestig door op OK te drukken. 

Wanneer een volgfunctie aan een uitgang is toegekend, is het niet meer mogelijk om een
andere volgfunctie aan dit uitgang toe te kennen. 

 Wanneer meerdere uitgangen eenzelfde uitgang moeten volgen, verzamel in een
groep de verschillende volguitgangen. Verbind de groep aan het te volgen uitgang. 

Automatische volgers

Sinds de 1.16.13 versie is het mogelijk om de volgers voor de terugkoppelingsled van de
drukknoppen  (de  afbeeldingen  van  de  DPLCD-modules  zijn  aan  terugkoppelingsleds
gelijkgesteld) automatisch te scheppen,.  

Procedure :

1. Maak linken tussen de  uitgangen en de  ingangen die over terugkoppelingsleds
beschikken. 

2. Klik rechts op de pictogram Volgers en kies Volger groepen aanmaken.  

Dit functie maaktt een groep aan van leds in de  uitgangenkolom en een volger in de
ingangenkolom. De volger in de  ingangenkolom verbindt de  uitgang die van staat zal
veranderen aan de ledgroep die juist werd aangemaakt,   

De volger is aangemaakt  als een link geprogrammeerd is en dat de led of de afbeelding
van de ingangmodule niet overgenomen is in een andere gedeelte van de programma (in
een link, een voorwaarde, een groep, een sfeer,..). 

 Bijvoorbeeld : een automatische volger aangemaakt voor de link van een relais van een
DBIR01-module bestuurd door één knop. 

 Bijvoorbeeld : een  automatische volger aangemaakt voor de  link van een relais van
een DBIR01-module bestuurd door meerdere knoppen. 
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 Voer alle linken van de programmatie uit. Op het einde van de programmatie, maak
dan  de volggroep aan.. 

Periodieke gebeurtenissen
Gebeurtenissen die zich regelmatig herhalen, bij elke ingestelde tijdsperiode. De eerste
periode begint op het einde van de initialisatie van de master, juist  na de overbracht van
een applicaite of van een herstartactie van de DGQG01. 

Het  schema  hieronder  illustreert  de  besturing  van  een  uitgang  via  een  periodieke
gebeurtenis. De functie die ze verbindt is een afwisselend ON/OFF actie. De gebeurtenis
herhaalt zich achter elke periode. 

Het doel van deze gebeurtenissen is om repetitieve acties te realiseren zonder gebruik te
maken van een behandeling van de gebruiker. .

 Bijvoorbeeld : een verwarmingssysteem beschikt over meerdere circuits. Wanneer er
tenminste één circuit verzoekt is, moet de circulatiepomp starten. Wanneer er geen enkel
circuit  verzoekt  is,  moet  de circulatiepomp stoppen. Een periodieke controle  biedt  een
snelle oplosssing in dit soort programmatie.

De  periodieke gebeurtenissen kunnen de  staat  van  gegroepeerde uitgangen in  een
groep regelmatig controleren. Volgens de staat van één of meerdere  uitgangen van de
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groep kan een geprogrammeerde actiesoort plaats nemen.  

 Om  de  communicatie  op  de  BUS  niet  te  overbelasten,  beperkt  het  aantal
gebeurtenissen  die  periode  van  korte  tijdsduur  hebben  (5  seconden  is  de  minimale
aangeraden uitstel).  

Aaanmaak van een periodieke gebeurtenis

Procedure : 

1. Klik rechts op de pictogram Periodieke gebeurtenis > Bijvoegen van 
gebeurtenis.

2. Geef een naam aan de nieuwe gebeurtenis.

3. Bepaal de tijdsduur van de periode. 

4. Bevestig door op OK te drukken. 

 Bijvoorbeeld : de gebeurtenis Water geven zal een actie op de uitgang(en) waaraan ze
verbonden is alle 1h30 uitvoeren.

Aanmaak van linken vanaf een periodieke gebeurtenis 
Het gebruik van een periodieke gebeurtenis vereist de aanmaak van een link tussen deze en de
uitgang(en)  die bestuurd moet(en) worden. Door te  slepen-loslaten,  programmeer linken. Voor
meer informatie raadpleeg het hoodstuk Basisacties : relais-type uitgangmodules op drukknop-type
ingang (p73)
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 Sommige  linken  die  opgenomen  zijn  in  het  hoodstuk Basisacties :  relais-type
uitgangmodules  op  drukknop-type  ingang (p73)  zijn  niet  beschikbaar  in  de  functie
periodieke gebeurtenissen. Een link met een relaismodule laat de actie  vasthouden niet
toe. 

Gebeurtenis bij verandering
Gebeurtenis die uitgevoerd wordt na de staatverandering van een andere uitgang. Volgens
de actie uitgevoerd op de eerste uitgang die werd geplaatst in de gebeurtenis bij 
verandering, ON, OFF of bij staatverandering, een uitgevoerde actie op een tweede 
uitgang. 

 Bijvoorbeel : de lamp van mijn toilet is onafhankelijk van de ventilatie van mijn toilet.
Wanneer ik het licht uitdoe begint de ventilatie een temporisatie van 5 minuten.

 De gebeurtenis bij verandering is een goede alternatief aan de programmatie van
te korte periodieke gebeurtenissen. 

Aanmaak van een gebeurtenis bij verandering

Procedure : 

1. Door  te  slepen-loslaten,  breng  de  uitgang waarvan  haar  staatverandering  de
veranderingen zal veroorzaken.  

2. Door te slepen-loslaten, breng de uitgang die, na de staatverandering van de eerste
uitgang, de gebeurtenis uitvoert.   

3. Kies de soort van verandering die de actie inschakelt. ON, OFF of staatverandering.

4. Kies  het  gewenste  actietype.  Voor  meer  informatie,  lees  hoodstuk  Basisacties :
relais-type uitgangmodules op drukknop-type ingang (p73)
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5. Bevestig door op OK te drukken. 

Bepaalde linken, de voorwaarden
Een link kan zich volgens sommige voorwaarden uitvoeren. De uitgang schakelt zich 
enkel in als alle voorwaarden gecontroleerd zijn. 

De voorwaarden kunnen zijn :  de staat van een ingang ; 

de staat van een uitgang ; 

de staat of de waarde van een gedimd 
uitgang ; 

de temperatuur van een temperatuursensor ;

lde waarde van een uurwerk ;

de staat of de waarde van een variabel ; 

de staat of de waarde van een 
variabelsysteem ;

de staat of de waarde van een audiouitgang ;

de staat van de groepen ;  

de staat van de sferen ; 

de staat, de mode of de snelheid van de 
DFAN01 ; 

de waarde van een analogisch signaal 0-10V ;

de waarde van een DMX-kanaal ;

de waarde van een DINTDALI01-kanaal.
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Toevoegen van een voorwaarde

Procedure :

1.  tijdens het  aanmaken van een link,  kies de tab  voorwaarde van het  onderstaande
scherm. 

2. Klik rechts op de eerste lege lijn van de tabel onderaan het venster en kies de optie
bijvoegen aan de voorwaarde om het instellingenvenster van de voorwaarde te openen.

3. Kies de tab van de gewenste voorwaardetype (ingang, uitgang, dimmer, enz.).

4. Kies de voorwaarde en bepaal haar instellingen. 

5. Klik op bijvoegen. De voorwaarde verschijnt in de lijst. 
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6. Voeg een andere voorwaarde als het nodig is.  
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7. Bevestig door op OK te drukken. Het venster van het aanmaak van linken toont nu alle 
voorwaarden toegepast aan de link aan. 

 Het gaat hier over een voorwaardeprogrammatie van het type EN (AND). Om een
voorwaarde van het type OF (OR) te vormen, moet u de basislink tussen de ingang en de
uitgang, het aantal keren dat de voorwaarde van het type OF gewenst is, herhalen. 

Soort van voorwaarden

Voorwaarde op een ingang     :

Optie ON : de link zal enkel uitgevoerd worden als de geselecteerde ingang geactiveerd 
          is.

Optie  OFF :  de  link  zal  enkel  uitgevoerd  worden  als  de  geselecteerde  ingang
uitgeschakeld is. 

Voorwaarde op een uitgang     :

Optie ON : de link zal enkel uitgevoerd worden als de geselecteerde uitgang geactiveerd
is. 

Optie  OFF :  de  link  zal  enkel  uitgevoerd  worden  als  de  geselecteerde  uitgang
uitgeschakeld is. 

Voorwaarde op de gedimd uitgang     : 

Optie  ON : de link zal enkel uitgevoerd worden als de geselecteerd  gedimde uitgang
geactiveerd is.

Optie  OFF : de link zal enkel uitgevoerd worden als de geselecteerd  gedimde uitgang
uitgeschakeld is.

Optie  Bovenop van :  de  link  zal  enkel  uitgevoerd  worden  als  de  waarde  van  de
geslecteerd gedimde uitgang hoger is dan de waarde van de instructrie. 

Optie Onderaan  van :  de  link  zal  enkel  uitgevoerd  worden  als  de  waarde  van   de
geselecteerd gedimde uitgang lager is dan da waarde van de instructie. 
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Voorwaarde op een temperatuur     :

Volgens de temperatuur dat de sensor detecteert. 

Optie T° hoger dan : de link zak enkel uitgevoerd worden als waarde doorgegeven door de
geselecteer temperatuursensor hoger is dan de aangegeven waarde. 

Optie T° lager dan : de link zal enkel uitgevoerd worden als de waarde doorgegeven door
de geselecteerd temperatuursensor lager is dan de aangegeven waarde.  

Optie T° gelijk aan : de link zal enkel uitgevoerd worden als waarde doorgegeven door de
geselecteerd temperatuursensor gelijk is aan de aangegeven waarde. 

Optie  T°  begrepen  tussen  :  de  link  zal  enkel  uitgevoerd  worden  als  de  waarde
doorgegeven door de geselecteerd temperatuursensor begrepen is tussen de vermelde
temperatuurwaarden T1 en T2. 

Volgens de instructie van het temperatuurprofiel.

Optie Instructie hoger dan : de link zal enkel uitgevoerd worden als de instructie hoger is
dan de aagegeven waarde. 

Optie  Instructie lager dan : de link zal enkel uitgevoerd worden als de instructie lager is
dan de aangegeven waarde. 

Optie Instructie gelijk aan : de link zal enkel uitgevoerd worden als de instructie gelijk is
aan de aagegeven waarde. 

Optie  Instructie begrepen tussen  : de link zal enkel uitgevoerd worden als de instructie
tussen de vermelde instructiewaarden T1 en T2 begrepen is. 

 Selecteren  van  de  temperatuurmode  van  de  sensor :  automatische  mode,
afwezigheidsmode, comfortmode, bevriezingsmode. Als dit extra beperking niet gewenst
is, laat de optie alle modes geactiveerd. 

 Selecteren  van  de  regelingsmode  van  de  sensor :  verwarmingsmode,
verfrissingsmode, gemengdmode, OFF mode. Als dit extra beperking niet gewenst is, laat
de optie alle modes geactiveerd.  

Voorwaarde op een uurwerk     : 

Optie Uur Na : de link zal enkel uitgevoerd worden als de ingang geactiveerd wordt na het
instructieuur.  
Optie Uur Voor : de link zal enkel uitgevoerd worden als de ingang voor het instructieuur
geactiveerd wordt. 

Optie Uur begrepen tussen : de link zal enkel uitgevoerd worden als de ingang tussen de
instructieuren geactiveerd wordt. 

Optie Datum begrepen tussen : de link zal enkel uitgevoerd worden als de ingang tussen
de aangegeven data geactiveerd wordt. 

Selecteren  van  de  dag  van  de  week :  de  link  zal  volgens  de  opties  die  hierboven
teruggenomen zijn en als de dag van de week geseleteerd is uitgevoerd worden. 
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Selecteren van een dag, een maand, een jaar : de link zal volgens de opties die hierboven
teruggenomen zijn en als de dag en/of de maand en/of het jaar met het moment van de
actie overeenkomt uitgevoerd worden.  

Voorwaarde op een audio-uitgang     :

Optie  ON :  de  link  zal  enkel  uitgevoerd  worden  als  de  geselecteerd  audio-uitgang
geactiveerd is (tenminste 1%).

Optie  OFF :  de  link  zal  enkel  uitgevoerd  worden  als  de  geselecteerd  audio-uitgang
uitgeschakelt is (0%).

Optie Boven van : de link zal enkel uitgevoerd worden als de volume van de geselecteerd
audio-uitgang hoger is dan de instructiewaarde.

Optie Onder van : de link zal enkel uitgevoerd worden als de volume van de geselecteerd
audio-uitgang lager is dan de instructiewaarde. 

Voorwaarde op een DFAN01-uitgang     :

Volgens de Mode 

Optie  Automatische  mode  :  de  link  zal  enkel  uitgevoerd  worden  als  de
airconditioningsmode op automatisch staat. 

Optie Manuele mode : de link zal enkel uitgevoerd worden als de airconditoningsmode op
manueel staat.  

Volgens de Snelheid 

Optie Off : de link zal enkel uitgevoerd worden als de ventilatiesnelheid aan 0 staat.

Optie Snelheid 1: de link zal enkel uitgevoerd worden als de ventilatiesnelheid op snelheid
1 staat. 

Optie Snelheid 2: de link zal enkel uitgevoerd worden als de ventilatiesnelheid op snelheid
2 staat. 

Optie Snelheid 3: de link zal enkel uitgevoerd worden als de ventilatiesnelheid op snelheid
3 staat. 

Volgens de Staat

Optie  Off :  de link zal  enkel  uitgevoerd worden als de staat  van de contacten van de
airconditioning uitstaat (OFF). 

Optie Verwarming : de link zal enkel uitgevoerd worden als de staat van de contacten van
de airconditioning op verwarming staat.

Optie Verfrissing : de link  zal enkel uitgevoerd worden als staat van de contacten van de
airconditioning op verfrissing staat. 

Voorwaarde op een DMX-uitgang     : 

Optie Boven van : de link zal enkel uitgevoerd worden als de waarde van het geselecteerd
DMX-kanaal hoger is dan de instructiewaarde.  
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Optie Onder van : de link zal enkel uitgevoerd worden als de waarde van het geselecteerd
DMX-kanaal lager is dan de instructiewaarde. 

Optie  Gelijk : de link zal enkel uitgevoerd worden als de waarde van het geselecteerd
DMX-kanaal gelijk is aan de instructiewaarde. 

Optie  ON :  de  link  zal  enkelk  uitgevoerd  worden  als  het  geselecteerd  DMX-kanaal
geactiveerd is (tenminste 1%). 

Optie OFF : de link zal enkel uitgevoerd worden als het geselecteerd DMX-kanaal 
uitgeschakelt is (0%). 

Voorwaarde op een analogisch uitgang van 0 à 10 Vdc (DD10V oh DOUT10V02):

Optie  Boven van :  de link zal  enkel  uitgevoerd worden als de waarde de geseleceerd
analogisch ingang hoger is dan de instructiewaarde. 

Optie Onder van : de link zal enkel uitgevoerd worden als de waarde van de geselecteerd
analogisch ingang lager is dan de instrucitewaarde. 

Optie  Begrepen  tussen :  de  link  zal  enkel  uitgevoerd  worden  als  de  waarde  van  de
geselecteerd analogisch ingang begrepen is tussen de geselecteerde waarden.

Optie  Gelijk :  de  link  zal  enkel  uitgevoerd  kunnen  worden  als  de  waarde  van  de
geselecteed analogisch ingang gelijk is aan de gemeten waarde. 

Voorwaarde op een groep     :

Optie Tenminste X uitgangen ON : de link zal enkel uitgevoerd worden wanneer het aantal
geactiveerde uitgangen in een groep hoger of gelijk zijn dan de ingestelde parameter . 

Optie Tenminste  X uitgangen OFF :  de  link  zal  enkel  uitgevoerd worden wanneer  het
aantal  uitgeschakelde  uitgangen  in  een  groep hoger of  gelijk zijn  dan  de  ingestelde
parameter..

Optie  Precies X uitgangen ON : de link zal enkel uitgevoerd worden wanneer het aantal
geactiveerde uitgangen in groep gelijk zijn aan de ingestelde parameter.  

Optie  Alles ON :  de link zal enkel uitgevoerd worden als alle uitgangen van de  groep
geactiveerd zijn. 

Optie Alles OFF :  de link zal enkel uitgevoerd worden als alle uitgangen van de  groep
uitgeschakeld zijn.

Voorwaarde op een sfeer

Optie Identieke sfeer :   de  link  zal  enkel  uitgevoerd  worden als  alle  waarden  van  de
uitgangen van  de  sfeer  dezelfde  waarden  hebben  als  die  die  ingesteld  zijn  in  de
parameters van de geselecteerde sfeer. 

Optie  Verschillende  sfeer :  de  link  zal  enkel  uitgevoerd  worden  als  de  waarde  van
tenminste  één  uitgang  van  de  sfeer  verschillend  is  van  die  die  ingesteld  is  in  de
parameters van de geselecteerde sfeer. 
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Voorwaarde op een systeemvariabel     :

Volgens de aanwezigheidsimulatie

Optie  Waarde  : de link zal enkel uitgevoerd worden als de waarde van de geselecteerd
systeemvariabel gelijk  is  aan  instructiewaarde.  De  aanwezigheidsimulatie  is  actief
wanneer de waarde waar is. De aanwezigheidsimulatie is inactief wanneer de waarde vals
is. 

Volgens men in dag of nacht staat volgens de astronomische uurwerk.

Optie Overdag : de link zal enkel uitgevoerd worden als de waarde van de geselecteerd
systeemvariabel gelijk  is  aan  de  instructiewaarde.  De  waarde  dag begint  vanaf  de
zonsopgang en de waarde nacht begint vanaf de zonsondergang. 

Voorwaarde op een variabel     :

Optie  Waarde : de link zal enkel uitgevoerd worden als de waarde van de geselecteerd
variabel gelijk is aan de waarde van de instructie. Als het over een variabel van het type
waarde gaat, zal de status waar of vals zijn.  Als het over een waardevariabel gaat, zal ze
van  0  tot  100  begrepen  zijn.  Voor  meer  informatie,  lees  de  hoofdstuktitle  De
variabels(p115)

Optie Boven  van  :  de  link  zal  enkel  uitgevoerd  worden  als  de  waarde  van  de
geselecteerde variabel hoger is dan de instructiewaarde. 

Optie Onder van : de link zal enkel uitgevoerd worden als de waarde van de geselecteerde
variabel lager is dan de instructiewaarde.
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De variabels
De variabels zijn informaties bevat in het geheugen van de master (DGQG01) en het
geheugen van het systeem. Het gebruik van de variabels in de voorwaarden laat toe om
ingewikkeldere linken tussen ingangen en uitgangen te scheppen. 

De  variabels  kunnen  onder  de  vorm  van  fictieve  Waar/Onwaar uitgangen  of  van
numerieke waarden voorkomen. 

 Bijvoorbeeld : gebruik van een variabel  WAAR/ONWAAR  om een functie tijdens een
bepaalde periode van de dag te blokkeren. 

 Bijvoorbeeld :  gebruik  van  een  numerieke variabel  om  het  verloop  van  5
opeenvolgende functies op eenzelfde knop te programmeren (Bv. : 5 verschillende sferen).

Aanmaak van een variabel 

Procedure : 

1. Klik rechts op de pictogram variabels in de uitgangenkolom.

2. Geef een nieuwe naam aan de gemaakte variabel.

Instellingen van de variabels

Het gebruik van de variabels vereist het bepalen van het type van variable. 

• De variabels van het type Waar/Onwaar : 
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Twee  mogelijke  waarden :  waar of  onwaar.  De  acties  op  dit  variabeltype  zijn
vergelijkbaar aan een relaisuitgang (aan of uit ; ON of OFF) 

• De variabels van het type Waarde (numerisch :  

Mogelijke waarden : een getal begrepen tussen 0 en 100. De limietwaarde van deze 
variabel is instelbaar via de keuzelijn Limiet. 

• De waarde van de variabel kan geloopt worden : wanneer de verhoogde variabel haar 
limietwaarde bereikt heeft, begint ze haar cyclus opnieuw. Deze optie wordt geactiveerd
door het vakje loopen van de waarden aan te vinken. 

Wijzigen van de staat van de variabels

De staatverandering van een variable voert zich via een ingang uit (Bv. : drukknop). 

Wijziging van de waarde van een variabel van het type waar/onwaar.

Een  actie  op  een  ingang zal  de  oorspronkelijke  staat  van  de  variabel omkeren.  De
mogelijke acties zijn :  

• Afwisselend Waar/onwaar : een eerste druk op de ingang kan de activering van de
variabel zijn. Een tweede druk schakelt de variabel uit. 

• Waar : een druk activeert de variabel. .

• onwaar : een druk schakelt de variabel uit. 

• Vasthouden en temporisatie : meer informatie in het hoodstuk  Basisacties : relais-
type uitgangmodules op drukknop-type ingang (p73) 

Wijzigen van de waarde van een numerieke variabel.

De waarde van een waardevariabel kan verhoogd, verlaagd of aan een bepaald waarde
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gebracht worden.  Deze  verandering  neemt  plaats  vanaf  een  impuls  op  de  ingang
verbonden aan de variabel. Het scheppen van de link leidt tot de volgende acties : 

• Verhogen :  de waarde van de variabel verhoogt van één eenheid na elke inpuls op de
ingang van de link.  

• Verminderen : de waarde van de variable vermindert van één eenheid na elke impuls
op de ingang van de link. 

• Waarde  : de variabel heeft als waarde het aantal gekozen, in de keuzelijst, Waarde na
een impuls op de ingang van de link. 

• Afwisselend Waarde/0 : de variabel heeft als waarde het aantal gekozen in de keuzelijst
Waarde na een impuls op de  ingang van de link. Een nieuwe impuls op de ingang
veroorzaakt de reset van de variabel.  

 Het gebruik van de mode autonoom master en actief PC laat toe om via de PC de
status  van  de  variabel  te  veranderen.  Voor  een  waardevariabel  gaat  het  over  een
waardeverandering van 0 tot haar maximale waarde ingesteld tijdens haar creatie.    

Aanwezigheidssimulatie
De  aanwezigheidssimulatie reproduceert  de  gewoontes  van  de  bewoners  van  het
gebouw. Wanneer ze actief  is,  schakelt  ze de acties die een week vooraf  opgeslagen
werden. Het is mogelijk om enkel een gedeelte van uitgangen te selecteren.  
Het  opslaan  op  een  periode  van  een  week  is  onder  de  vorm  van  een  mobiele
« cirkelvormig buffer » uitgevoerd. Het syteem voert een doorlopend actualisering van de
simulatie uit. 

Selecteren van de uitgangen die bestuurd moeten worden tijdens de simulatie

Dit behandeling bestaat uit de uitgangen waarvoor het systeem de staat zal opslaan te
bepalen en dan de staat te herproduceren tijdens de simulatie. Via het menu  Project >
Aanwezigheidssimulatie. Het venster laat toe om de uitgangen die moeten opgeslagen
worden te selecteren.  

Handleiding van Domintell2 1.24 software   Updated op  18.09.2015  © Alle rechten voorbehouden aan Trump SA    www.domintell.com

117

http://www.domintell.com/


 De lamp van een toilet die geen venster heeft, of de verwarmingsregulatie zullen niet
geselecteerd worden. 

Activeren van de simulatie

De systeemvariabel  aanwezigheidssimulatie activeert de  aanwezigheidssimulatie. De
programmatie van deze variabel is vergelijkbaar met de programmatie van een variabel
van het type Waar/Onwaar. De activering van de simulatie kan zich dus via om het even
welke ingang worden uitgevoerd : knop, touchscreen, ontvangen van een SMS, klok,...  

Procedure :  
1. Kies  de  systeemvariabel  Aanwezigheidssimulatie.  Door  te  slepen-loslaten,

verplaats het naar de gewenste ingang. 

2. Kies  de  gewenste  actie.  (Voor  meer  informatie,  raadpleeg  het  hoofdstuk  De
variabels (p115).

3. Bevestig door op OK te drukken.

De aanwezigheidssimulatie kan onmiddelijk geactiveerd worden via een touchscreen.

1. Voor de DTSC01- en DTSC03-schermen: via het configuratiemenu van het scherm,
kies  het  submenu  Beheer  van  de  veiligheid.  Op  deze  plaats  bevindt  zich  de
pictogram  van  de  variabel  Aanwezigheidssimulatie.  Dit  type  besturing  vereist
geen enkel link in de configuratieprogramma.  
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2. Voor  de  DTSC02-  en  DTSC04-schermen  :  via  het  configuratiemenu  van  het
scherm,  kies  het  submenu  Tools.  Op  deze  plaats  bevindt  zich  de  variabel
Aanwezigheidssimulatie.  Dit  besturingstype  vereist  geen  enkel  link  in  de
configuratieprogramma. 

Omdat  het  systeem  een  hele  week  nodig  heeft  om  de  staten  van  de  uitgangen  te
onthouden,  zal  de simulatie  enkel  een week na de ingebruikneming van de installatie
kunnen  werken.  Dit  uitstel  is  ook  van  toepassing  bij  elk  nieuw  doorzending  van  de
applicatie naar de master DGQG01. De gegevens van de aanwezigheidssimulatie zijn in
het RAM-geheugen van de DGQG01 opgeslagen. Om de staat van het opslaan van de
aanwezigheidssimulatie te kennen, raadpleeg het menu Hulp > Simulatie. 

Uurwerken of klokken
De uurwerken voeren acties op een precies moment uit. Het uurwerk regelt zich op een
tijdsblok van 24 uur verbonden aan eenwekelijks uurrooster en aan een precies dag-,
maand- of jaarselectie. De uurwerken zijn inbegrepen in het DGQG01-Master-geheugen.
De aantal mogelijke uurwerken werden gelimiteerd op 250.   

Uurwerktype

*  Classieke  uurwerken :  op  een  bepaald  moment  schakelt  een  actie  die  we
geprogrammeert hebben in.

* Astronomische uurwerken : deze past zich automatisch aan aan de zonsopgang en
-ondergang volgens de preciese datum en de geografische ligging van de installatie. Het is
mogelijk om een actie ten opzichte van deze klok uit te stellen of te anticiperen. 

* Klok bij het opstarten : Mogelijkheid om een bepaald aantal acties uit te voeren bij het
opstarten van het systeem (DGQG01 – Master) om  uitgangen in bijzondere staten te
zetten. Dit voert zich op het einde van de initialisatieperiode van de DGQG01 uit.

Aanmaak van de uurwerken

Procedure :

1. Klik  rechts  op  de  pictogram  Uurwerken (ingangenkolom)  >  Klok  bijvoegen ;
astronomische klok bijvoegen ; voeg een start klok toe. 

2. Standaardklok : klok toevoegen :
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1. Geef de nieuwe klok een naam. 

2. Bepaal de instellingen van de klok :

Uur : bepaalt de exacte tijdstip waarop ge gebeurtenis plaats zal nemen.  

Week : bepaalt de dagen van de week waarin de gebeurtenis plaats zal
nemen. 

Keuze van de dag  : bepaalt de  dag van een  maand van een  jaar, een
volledige  maand,  een  volledige  jaar of  een  exacte  datum waarin  de
programmatie zal plaatsnemen.  

3. Bevestig door op OK te drukken. 

1. Astronomische klok : astronomische klok toevoegen

1. Geef de nieuwe klok een naam

2. De stad die verschijnt onder de naam van de klok wijst naar de stad waarvan de
gegevens teruggenomen zijn voor de zonsopgang en zonsondergang. Om die te
wijzigen, klik rechts op de naam van de stad > wijzig de stad > kies de stad die
het dichtste is van uw Domintell-installatie

Dit venster toont het uur van de zonsopgang en zonsondergang aan. Maar ook de
extreme uren op de 52 weken van het jaar. 

3. De astronomische  klok kan  een  actie  ofwel  bij  de  zonsopgang  ofwel  bij  de
zonsondergang uitvoeren. Het uur van de opgang en ondergang verschijnt in het
rood.  

4. Bepaal de instellingen van de klok. Mogelijkheid om het inschakelen van de klok te
anticiperen of uit te stellen. Voor meer informatie over de instellingen van de klok,
lees de title Bepaal de instellingen van de klok : (p120).

5. Bevestig de parameters door op OK te drukken. 
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1. Klok bij het opstarten : voeg start klok toe

1. Geef de nieuwe klok een naam. 

2. De klok bij het opstarten voert haar programmatie uit zodra de DGQG01-module
zijn initialisatie uitvoert. Dit voert zich uit na de overdracht van een applicatie
naar de master.  

3. Bevestig door op OK te drukken.

 Mogelijkheid om de klokken te sorteren om meer duidelijkheid in uw programmatie te 
brengen. 

Wijzigingen van de parameters van een klok

Het is mogelijk om op elk moment de parameters van een klok te wijzigen : klik rechts op
de klok > bewerken. Het configuratievenster opent zich en laat u toe de parameters te
wijzigen. 

Het  is  ook  mogelijk  om  een  klok  te  wijzigen  via  de  touchscreens.  Om  dit  te  doen,
raadpleeg het hoofdstuk 

Aanmaak van linken op een klok

De activering van een uitgang op een precies moment vereist de aanmaak van een link
tussen een uitgangselement en een voordien gecreëerde klok. Deze aanmaak van link is
dezelfde voor de standaard klokken, de astronomische klokken en de start klokken. 

Het  linkse  gedeelte  van  het  venster  toont  de  parameters  van  de  klok  aan :  naam,
activeringsuur en de  werkingsperiodes. Het is mogelijk om deze parameters onmiddelijk
via dit scherm te wijzigen door op de knop Klok te drukken.  
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Volgens de natuur van de verbonden uitgang, kies de gewenste actie. 
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Temperatuursbeheer
Het Domintellsysteem laat toe om acties volgens de temperatuur die gemeten is door domotische 
sensoren uit te voeren.  Er zijn twee types acties. Ofwel een klimaatregeling, ofwel een logica test 
aan de gemeten temperatuur toegepast. 

Regelingstype
Het Domintellsysteem beschikt over 4 actietypes. Het gaat over 3 regelingtypes en één actietype
in functie van een waarde van de temperatuur. De regelingen zijn :  evenredige regeling, alles of
niets regeling en de  DFAN01 regeling. Die regelingen zijn voor  het verwarmings- of  voor  het
afkoelingsbeheer beschikbaar.  

Evenredige regeling

1. Voor een uitgang van het type Relais 

Voor een bepaald periode, is de activatietijdsduur van de uitgang evenredig aan het
temperatuurverschil tussen de instrucite en de waarde gemeten door de sensor.

2. Voor een uitgang van het type Dimmer

Er wordt geen rekening meer gehouden met de periode. De waarde van de uitgang zal
recht evenredig zijn met het temperatuurveschil tussen de gemeten temperatuur en de
instructietemperatuur. 

• Schema  

3 vooringestelde evenredige regelingen zijn voorgesteld. Mogelijkheid om de regeling te 
personaliseren. 

    * Snel : periode = 5 min; evenredige stap = 1,5°C

    * Gemiddeld : periode = 10 min; evenredige stap = 2,5°C
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    * Traag : periode = 20 min; evenredige stap = 3,5°C

    * Aangepast : laat toe om de regelingsintellingen te wijzigen. 

AAN/UIT regeling

Als de temperatuur hoger is dan de instructietemperatuur, wordt de  uitgang uitgeschakkeld.
Als de temperatuur lager is dan de instructietemperatuur verlaagd van de hysteresis waarde,
wordt de uitgang ingeschakkeld.

Voor de regelingen van het type evenredig of alles of niets, is het beheer van de activatie van de
uitgang omgekeerd ten opzichte van het beheer van de verwarming. 

1. Voor de verwarming, wordt de  uitgang geactiveerd als de gemeten temperatuur lager is
dan de instructietemperatuur minder de hysteresis waarde. 

2. Voor de afkoeling, wordt de uitgang geactiveerd als de gemeten temperatuur hoger is dan
de instructietemperatuur plus de hysteresis waarde. 

• Alle Domintellsensoren zijn in staat om een verwarming- en een afkoelingsprofiel te beheren.
Volgens de mogelijkheden van uw installatie,  moet u één mode of de tweede   mode met
inbegrepen koelingsprofiel kiezen. 

DFAN01-regeling

Unieke  keuze  van  de DFAN01-regeling.  De  snelheden  van  de  DFAN01-module  zijn
ingeschakkeld  volgens  het  temperatuurverschil  tussen  de  instructietemperatuur  en  de
gemeten  temperatuur.  De  verwarming-  of  de  afkoelingsrelais  worden  volgens  dit
temperatuurverschil gecontroleerd. .

Acties in functie van een temperatuurwaarde

Het gaat over de actie van een  uitgang in fucntie van een logische test toegepast aan de
gemeten temperatuur. 

Handleiding van Domintell2 1.24 software   Updated op  18.09.2015  © Alle rechten voorbehouden aan Trump SA    www.domintell.com

125

http://www.domintell.com/


Men onderscheidt 3 vergelijkings- of logische test modes : 

Kleiner : de uitgang zal geactiveerd worden als de gemeten temperatuur lager is dan
de instructietemperatuur.  

Groter : de  uitgang zal geactiveerd worden als de gemeten temperatuur hoger is
dan de instructietemperatuur. 

Gelijk : de uitgang zal geactiveerd worden als de gemeten temperatuur gelijk is aan
de instructietemperatuur.

Programmatie van de airconditioning 

Om de programmatie van de airconditioning te bereiken, voer 
een link tussen een uitgang en een temperatuursensor uit. 

De uitleg van de keuze van de regelingstype worden in het hoofdstuk  Regelingstype 
(p124) beschreven. 

Het beheer van de verwarming en/of van de koeling kiezen

Volgens de capaciteiten van het element dat geconnecteerd is aan de  uitgangmodule,
kies de mode verwarmingsbeheer en/of koàelingsbeheer. 

De  keuze  van  het  verwarmings-  of  koelingsbeheer voert  zich  uit  in  het  venster  Link
aanmaken. (niet de temperatuursensor)

1. Als  de  uitgang enkel  het  beheer  van  de  verwarming  bestuurt,  kies  enkel
verwarming beheer. 

 Bijvoorbeeld, een gazketel

2. Als de uitgang enkel het beheer van de koeling bestuurt, kies enkel koeling beheer.

 Bijvoorbeeld, unieke koelingsgroep.

3. In het geval van een unieke airconditioning circuit (2 pijpen), als de uitgangmodule
in  staat  is  om de  verwarming  en  de  verfrissing  te  beheren,  kies  de  2  modes
(verwarming beheer en koeling beheer).
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 Bijvoorbeeld, warmtepomp Inverter.

4. In het geval van een dubbele airconditioning circuit (4 pijpen), het beheer van de
verwarming voert zich uit met een uitgangsmodule. Het beheer van de koeling voert
zich uit met een andere uitgangsmodule. 

 Bijvoorbeeld,  instelling  gebruikt  in  hotels.  Een  link  controleert  de  koude  groep,  de
andere link controleert de verwarmingsketel. Tijdens een periode tussen de seizoenen kan
een deel van het gebouw verwarmd worden et kan een andere deel verfrisd worden. 

Het beheer van de airconditioning voert zich uit op basis van een gesloten klep. Tijdens
het gebruik van een geopend klep is het mogelijk om de uitgang om te keren door de
optie omgekeerd uitgang in het venster link aan te maken en aan te vinken. 

Temperatuurverschil

Een regeling voert zich altijd uit via de instructie van de temperatuursensor. Domintell laat
toe om een temperatuur offset op deze instructie toe te voegen. Wanneer een temperatuur
offset geprogrammeerd wordt, zal de regeling zich op de instructie van de temperatuur
toegevoegd aan de temperatuur offset uitvoeren. 

 Bijvoobeeld,  de  badkamer  beschikt  over  een  vloerverwarming  en  een  elektrische
handdoekenwarmer. Het inschakkelen van de haddoekenwarmer kan over deze offset beschikken.
Wanneer de temperatuur te ver is van de instructie, zal de handdoekenwarmer inschakkelen om
de badkamer sneller te verwarmen.
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Temperatuurmode en regelingmode

Temperatuurmode

Elke temperatuursensor beschikt over een  temperatuurmode. De temperatuurmode van
een sensor laat het beheer van de klimatische installatie op het niveau van het beheer van
de temperatuurprofielen toe. 

Kies een automatisch, comfort, afwezigheidstemperatuur of antivries profiel. 

• Auto mode   : de temperatuurprofielen voor elke dag van de week zijn  
uitgekozen. 

• Comfort mode   : het comfortprofiel is geselectionneerd.

• Afwezigheid mode  : de afwezigheidstemperatuur is geselectionneerd. 

• Antivries mode   : de antivriestemperatuur is geselectionneerd. 

Om toegang te hebben aan de temperatuurmode in een link moet er een temperatuurzone
die een sensor bevat aangemaakt  worden.

Regelingmode

Elke temperatuursensor  beschikt  over  een  regelingsmode.  De  regelingsmode  van een
sensor  beheert  de  klimatsche  installatie  op  het  niveau  van  de  regeling.  De
regelingsmodes zijn voor elke temperatuursensor beschikbaar. 

• Gemengd mode : uitvoering van de linken (regeling) die het warm en het koud 
beheren. 

• Uit mode : de uitgangen aangesloten aan de regelingen zijn uitgeschakkeld. 

• Warm mode : uitvoering van de linken (regeling) die de warmte beheren. 

• Koud mode : uitvoering van de linken (regeling) die de  afkoeling beheren. 

Om toegang te hebben aan de regelingsmode in een link, moet er temperatuurzone die
de sensor bevat aangemaakt worden.

In  het  geval  van  een  beheer  in  de  gemengdemode,  wanneer  het  beheer  van  de
airconditioning  (warme  en  koude  bron)  in  één  enkel  toestel  gecentraliseerd  is,  zich
verzekeren dat de verandering van de regelingsmode op het niveau van de sensoren ook
gecommuniceerd wordt aan het airconditioning toestel. 

Instellingen van de temperatuursensoren
Alle Domintell-sensoren beshikken over het dubbele regelingsbeheer. Dit beheer laat toe
om de verwarming en de koeling door dezelfde sensor te beheren. 

Om de regeling correct te realiseren, moet elke Domintell-sensor ingesteld worden. Meer
informatie in het hoodstuk Algemene informatie   : temperatuur sonde (p  54  ).
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Toewijzen van de profielen

Alle Domintell-sensoren beschikken over 16 verschillende profielen, 8 voor het beheer van
de verwarming en 8 voor het beheer van de koeling. 

De automatische profielen die de 7 dagen van de week doorlopen beschikken over een
verwarming- en koelingprofiel. 

Het comfortprofiel bezit ook een verwarming- en koelingsprofiel. 

De afwezigheidstemperatuur is gemeenschappelijk aan alle temperatuursensoren. 

De antivriestemperatuur is gemeenschappelijk aan alle temperatuursensoren. 

• Profiel toewijzen : 

Voer  een  slepen-loslaten actie  vanaf  de  profielenlijst  tot  de  overeenkomstige
afbeelding uit. 

Een verwarmingsprofiel moet op de rode thermometer ingelogd worden. De rode
thermometer  stelt  de  verwarming  voor.  Een  koelingsprofiel  moet  op  de  blauwe
thermometer ingelogd worden. De blauwe thermometer stelt de koeling voor.  

• Profiel verwijderen :  

Klik rechts in de profielzone. Mogelijkheid om de verwarmings- en koelingsprofiel 
voor een gekozen dag te verwijderen. Ook mogelijk om alle profielen van de sensor
te verwijderen. 
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• Profiel kopiëren : 

Klik rechts in de profielzone en kies profiel kopiëren op andere sensor.

Temperatuurprofielen  op  andere  dagen  en/of  op  andere  temperatuursensoren
kopiëren. Kies de dagen waar het profiel moet toegewezen worden. Kies het profiel
dat gekopiëerd moet worden (verwarmings- en/of koelingsprofiel). Kies de sensoren
waar het profiel gekopiëerd moet worden. Bevestig door op OK te drukken. 

Om   de  klimatische  regeling  operationeel  te  maken,  moeten  alle  profielen  ingesteld
worden (voor de gewenste regelingstype). Als een profiel niet ingevuld is, verschijnt er een
bericht tijdens het versturen van de applicatie. De klimatsche regeling wordt in veiligheid
gezet als een profiel niet ingevuld wordt. 

Als  de  sensor  de  verwarmingsregeling  niet  beheerst,  is  het  aan  te  raden  om  de
verwarmingsprofielen niet in te vullen. Als de sensor geen koelingsregeling beheerst, is het
aan te raden de koelingsprofielen niet in te vullen. 

Afhankelijkheid van de sensors

Wanneer  meerdere  sensoren  de  klimatsche  regeling  vormen,  is  het  mogelijk  om een
afhankelijkheid tussen deze in te stellen. Een sensor kan Meester van één of meerdere
sensoren zijn. . 
De sensor slaaf volgt de sensor meester, 

• enkel voor zijn temperatuurmode,
• enkel voor zijn instructie, 
• enkel voor zijn regelingsmode,  
• of voor een combinatie van de 3 vorige opties. 

Procedure
1. Open het venster van afhankelijkheid van de temperatuursensoren. Via het menu

Project > Afhankelijk sensoren, via het bewerken van een temperatuursensor en
het wijzigen van het venster slaaf sensor. 

2. Kies een aanwezige sensor in de rechtse kolom en sleep het in de linkse kolom op
de sensor die meester zal zijn van deze sensor. 

3. Kies  het  gewenste  overnametype:  overname  temperatuurmode,  overname
regelingsmode, overname opdracht. 

Om een afhankelijkheid tussen 2 sensoren te verwijderen, klik rechts op de afhankelijke
sensor die verwijdert moet worden. Klik op weglaten. 
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 Bijvoorbeeld, een multizone bewoning beschikt over een warmtepomp Inverter. De sensor van
de living is de hoofdsensor van het huis. Wanneer deze van regelingsmode verandert, veranderen
alle andere sensors van regelingsmode. 

Temperatuurprofiel aanmaken
De automatisch  en comfort  modes  bestaan  uit  temperatuurprofielen.  De automatische
mode kan 7 verschillende profielen voor de 7 dagen van de week beheren. De comfort
mode gebruikt een vast profiel. 

Het is noodzakelijk temperatuurprofielen voor elke sensor te definiëren.

Procedure : 

1. Bewerk de sensor waarvoor de temperatuurprofielen moeten gedefiniëerd worden. 

2. Profiel > Bijvoegen/Wijzigen (links bonvenop). Of klik rechts op de profielenlijst
en kies Bijvoegen/Wijzigen.

3. Bepaal de verschillende blokken die de profiel vormen. Maximum 12 blokken op
een periode van 24 uur.  
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Temperatuurprofiel bijvoegen

Procedure : 

1. In de profielenlijst, klik op Nieuw. 

2. Klik links in de profielzone. Houd de linkse knop vast en beweeg de muis om het 
temperatuurprofiel te tekenen. Tijdens het loslaten van het linkse knop is de blok 
aangemaakt. 

3. De temperaturen kunnen direct ingevuld worden in het tabel rechts van het scherm.

4. Om een nieuwe profiel op te slaan, voer een naam in en klik op opslaan. Uw 
nieuwe profiel is dan aangemaakt. 
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Wijzigen van een bestaande temperatuurprofiel

Kies  het  profiel  dat  gewijzigt  moet  worden  in  de  profielenlijst.  Voer  de  gewenste
wijzigingen uit in de profielzone. Klik op Opslaan. 

Profiel verwijderen

Kies het profiel dat verwijdert moet worden in de profielenlijst. Klik op weglaten. Het

profiel is van de applicatie verwijdert. 

• Als het profiel in de applicatie gebruikt werd, wordt een bevestiging voor het verwijderen
van de module gevraagd. 

• Als een gebruikte profiel verwijdert is, zijn alle sensoren die dat profiel gebruikten niet 
meer ingesteld. 
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Technische ondersteuning

Opeenvolgende stappen van een standaard installatie

Stap 1: De loaders in de master en touchscreen controleren.
Stap 2: Netwerk scannen.
Stap 3: Alle ingangen en uitgangen herbenoemen.
Stap 4: Verdeling van de kamers en de verdiepingen. 
Stap 5: Groepen (uitgangen, geluid, luiken, enz.) aanmaken. 
Stap 6: Sferen aanmaken.
Stap 7: Uurwerken aanmaken. 
Stap 8: De astronomische klok aanpassen. 
Stap 9: Periodieke gebeurtenissen aanmaken. 
Stap 10: De gebruikers variabels aanmaken.
Stap 11; Temperatuurzones aanmaken. 
Stap 12: Door  slepen-loslaten,  de  linken  uitgangen-ingangen  aanmaken  en  de
functies toekennen. 
Stap 13: Temperatuurprofielen aanmaken.
Stap 14: Door slepen-loslaten, de linken verwarming-temperatuursensor aanmaken . 
Stap 15: De module geluid + IR zender/ontvanger instellen. 
Stap 16: De DGSM01-module instellen. 
Stap 17: De instelling uitlezen. 
Stap 18: De instelling naar de master sturen. 
Stap 19: De  instelling testen en de functies nakijken.
Stap 20: Een kopie van de instelling op een CD nemen. 
Stap 21: Een netwerkdiagnostiek van de installatie uitvoeren.
Stap 22: Alle  domotische  elementen  ten  minste  tijdens  2  uur  inschakkelen  om
verzekerd te zijn van de stabiliteit van het netwerk en van de laagspanningsvoeding op de
BUS.
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Reparatie 

Diagnose en maatregelen nemen.

Verificaties van de software

Voer de software uit om de installatie te controleren.  
Menu > Tools > netdiagnose.
Als er fouten zijn, moeten ze opgelost worden. 

Tijd en scherm van de DGQG01

De installatie op de juiste tijd zetten. 
Controleer op het scherm van de DGQG01 dat de 2 punten tussen de uren en de minuten
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knipperen. 

Batterij van de DGQG01

De accuspanning (type =  CR1216) van de DGQG01 moet hoger zijn dan 2.8Vdc. 
De batterij van de DGQG01 bevindt zich op de electronische PCB van de DGQG01. Open
de behuizing van de module voorzichtig aan de achterkant. 

Verbruik & elektrische dozen

Elke elektrische doos moet ten minste een DALI0x-voeding bevatten. Het verbruik van de
modules moet afzonderlijk berekend worden in de instellingsoftware. Het is aan te raden
de 2 Voedingsmodules niet met de voeding + (rode kabel) te connecteren. Deze maatregel
is nog  belangrijker voor de bedrading van de DALI03. 

Metingen op de BUS

Uw Domintell-systeem moet door een DALI0x gevoed worden.  

Met een multimeter     : alle voedingen ON
 ZWART - ROOD   Altijd > 14Vdc (alle relais ON) 
 ZWART – BLAUW   Data + : tussen 2 & 4 Vdc.
 ZWART -  WIT   Data - : tussen 1 & 3 Vdc. 

Verbindingen

De verbindingen via de BUS voeren zich best uit met de « Domintell DCBU01 » kabel.  
Respecteer de kleuren van de draden tijdens hun verbinding in de 
snelconnectorkoppeling. Gebruik een BUS-instelling. Vermijd de bedrading in STER. De 
instelling in STER vormt een verlies van kwaliteit van het domotisch signaal.  
Het is verboden om een simpele of totale LOOP in de bedrading van de BUS-datas te 
maken. De loop schept  spookberichten die de optimale werking van het systeem 
verhinderen.

Raadpleeg ook de video van de bedrading.
https://video-ams3-1.xx.fbcdn.net/hvideo-xat1/v/t43.1792-
2/10827418_887607721260572_1391635540_n.mp4?
efg=eyJybHIiOjE1MDAsInJsYSI6MTY1MX0%3D&rl=1500&vabr=602&oh=7cd7e017130e9
1155f35fa59b1678720&oe=55B7B153
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DDIM01 & vermogenmodules
De fase die geconnecteerd is aan de vermogenmodule (DD10V / DD400L/ DD75 / 
DD500 /  DD750 / DD1000) moet dezelfde zijn als die die geconnecteerd is aan de 
overeenkomende DDIM01-module. 
Raadpleeg de DDIM01 documentatie voor meer informatie. 

De DHUB01-module 
Enkel noodzakelijk als : 

• Er meer dan 128 modules op de BUS zijn en/of 
• De BUS een lengte van meer dan 300m heeft en/of
• Uw BUS in ster met een lengte van meer dan 100m bekabeld is. 

VEREISTE CONDITIES : elke DHUB01 moet een connectie op dezelfde lijn hebben als de
DGQG01 (centrale verwerkingseenheid)  : het is uw referentie op de BUS. 
Raadpleeg de DHUB01 documentatie voor meer informatie.

DTRP01 - DTRP02
De schakelaarsmodules hebben een belangrijke piekstroom nodig voor elke 
staatverandering. Domintell kan de goede werking van deze modules niet verzekeren als 
er geen DALI01-voeding is in dezelfde elektrische kast of als het aantal voedingen te laag 
is. Er kunnen maximum 32 schakelaars tegelijkertijd van staat veranderen als er maar één
DALI01 is. 
 
DGSM01
Voor de eerste programmatie van de DGSM01-module, moet de  batterij opgeladen zijn. 
Om de verzoeken van de DGSM01-module te behandelen, hebben we de screenshot van 
het staatvenster nodig : 
1.Laad uw applicatie en wacht op de initialisatie
2.Ga door naar de mode Actief PC
3.Klik rechts op de ingang DGSM01 => Status 
4.Neem een screenshot
5.Stuur het per email door

Logbestanden

• De technische ondersteuning kan u een logbestand vragen als het nodig is. 
• Ze worden in c:/Program_Files/Trump/Domintell2/Log opgeladen en behouden.
• Begin tijdens het starten van het Domintellsoftware.
• Einde wanneer u het Domintellsoftware verlaat.

Handleiding van Domintell2 1.24 software   Updated op  18.09.2015  © Alle rechten voorbehouden aan Trump SA    www.domintell.com

137

http://www.domintell.com/
file:///c:/Program_Files/Trump/Domintell2/Log


• Stuur het overeenkomende bestand enkel op de gewenste tijd door.

Technische ondersteuning

Voor meer informatie, contacteer de technische ondersteuning : support@domintell.com
Stuur het bestand met een volledig beschrijving, de diagnose en de resultaten van de
metingen op de BUS. De foto's en de screenshots kunnen ook opgestuurd worden om een
snelle diagnose toe te laten. 

Technische ondersteuning
Voor meer informatie, contacteer onze technische ondersteuning aan het volgende adres :

TRUMP ELECTRONICS S.A.

Rue de la Maîtrise 9

1400 Nivelles

België

Telefoon : +32 (0)67/888.250

Email : support  @  domintell.  com
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